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1 Per Iniziare

Introduzione

Portrait Professional e’ il modo piu’ facile e veloce per ritoccare ritratti, poiché permette di
ottenere risultati da professionisti in pochi minuti.

Portrait Professional lavora in modo completamente differente dai normali programmi di ritocco fotografico
utilizzati di solito dai professionisti. Infatti, essendo stato sottoposto a centinaia di esempi di bellezza umana,
Portrait Professional ti permette di migliorare le tue foto tanto quanto lo desideri semplicemente muovendo gli
slider. 

Grazie all'innata cognizione di bellezza inserita da principio nel software, chiunque può raggiungere la più alta
qualità di ritocco fotografico in pochi minuti.

Portrait Professional è disponibile in tre edizioni: Standard, Studio e Studio64. Le tre  versioni sono illustrate in
questo manuale.

Portrait Professional è disponibile per  Windows e Mac. Questo manuale è per le versioni Mac.

Per Iniziare

Guarda la Guida Avvio Rapido  per avere una prima visione d'insieme su come usare Portrait Professional.

La Guida Passo dopo Passo  ti fornirà maggiori e più dettagliate informazioni su ogni fase.

Se hai bisogno di ulteriore aiuto, visita il sito www.portraitprofessional.com/support, dove potrai vedere le più
aggiornate FAQ ed accedere al nostro sistema di richiesta di biglietto di supporto. Il sistema ti permetterà di
inviare richieste al nostro staff di assistenza.

1.1 Guida di Avvio Rapido

Portrait Professional vi guiderà nel processo di manipolazione dei volti. Potete usare la guida
veloce per familiarizzare con le diverse fasi.

Seleziona l’immagine da manipolare

Quando aprite il Portrait Professional apparirà una pagina di benvenuto. 

Cliccate sul pulsante “Apri” o selezionate Apri... dal menù “File”.

Anche se non avete un’immagine da modificare, potete utilizzare una delle foto di esempio.

Portrait Professional caricherà la vostra immagine sullo schermo,e i volti presenti nelle foto
verranno selezionati automaticamente.

Seleziona il volto che volete modificare

La prossima fase può variare in base al numero dei volti che sono stati rilevati
automaticamente nella vostra foto.
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Se è stato selezionato solo un volto

Comparirà il comando Seleziona il Genere , che mostrerà le linee di contorno del volto
trovato.

Se le linee di contorno sono posizionate correttamente intorno al volto, si può selezionare il
genere solo premendo il pulsante Donna o Uomo (o Ragazza o Ragazzo se il volto è
giovane). Questo vi condurrà alla prossima fase, nella quale potrete modificare le linee di
contorno.

Se le linee di contorno del volto non sono posizionate correttamente intorno al volto, cliccate
sul pulsante Rilascio linee di contorno. Le linee di contorno verranno cancellate e vi sarà
chiesto nuovamente di selezionare il genere del volto che volete modificare. Quando avete
selezionato il genere, dovrete selezionare manualmente il volto .

Se è stato selezionato più di un volto

Vedrete tutti i volti selezionati. Potete selezionarne uno per la manipolazione , o potete
localizzare il volto manualmente  se non è stato selezionato automaticamente.

Una volta modificato il primo volto, premete il pulsante Altro Volto per tornare alla fase 
Seleziona Volto  da quella di Modifica Volto  in modo tale da poter selezionare il
prossimo volto da modificare.

Se nessun volto è stato individuato

Se nessun volto e’ stato individuato automaticamente, un messaggio ve lo farà sapere.
Appena chiusa la finestra con il messaggio, sarete in grado di procedere manualmente alla
localizzazione del volto .
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Localizzare manualmente un Volto

Se il volto che volete modificare non e’ stato selezionato automaticamente, dovrete 
localizzarlo manualmente.

Visualizza l’immagine modificata e perfeziona i risultati

Una volta selezionato un volto (e aggiustate le linee di contorno, se necessario) potrete
passare alla fase Modifica Volto.

L’immagine originale vi apparirà alla destra dello schermo, mentre alla vostra destra la
versione modificata (potete cambiare questa impostazione usando i comandi Vedi Prima E
Dopo e Vedi Solo Dopo, collocati sopra l’immagine).

Tenendo premuto in pulsante ENTER potrete vedere la foto prima e dopo, per vederne i
progressi.

Se siete soddisfatti delle modificate effettuate, ciò significa che avete appena finito di
ritoccare la vostra prima immagine con Portrait Professional. Eventualmente potrete, in modo
semplice e veloce, ritoccare un’immagine già precedentemente modificata usando i controlli
alla destra dello schermo, facendo effettuare al soggetto una completa trasformazione,
oppure dandogli solo alcuni ritocchi per ottenere un effetto naturale.

In qualsiasi momento potete salvare le modifiche effettuate sul vostro ritratto semplicemente
selezionando “Salva” dal menù File  nella parte in alto a sinistra dello schermo.

Potete salvare l’intero lavoro selezionando “Salva Sessione”- questo vi permetterà di
continuare la manipolazione in futuro.

Occasionalmente, un posizionamento errato o approssimativo dei punti delle linee di
contorno del volto, possono causare la distorsione del volto stesso, o delle labbra. Per
ovviare a questo problema, dovrete aggiustare le linee di contorno mostrate nella fase Prima.
Muovendo i punti, potrete immediatamente vedere i cambiamenti nella fase Dopo.

Se ci sono più volti nella foto, premete il pulsante “Altri Volti” per tornare alla fase Seleziona
Volto .

1.2 Consigli Utili per Migliori Risultati

Se hai intenzione di leggere solo un pagina in questo manuale, fai in modo che sia questa, in quanto ti
permetterà di ottenere i migliori risultati con Portrait Professional.

Muovi i punti il meno possibile

In fase di Regolazione del Contorno , cerca di mettere i punti nella posizione corretta muovendoli il meno
possibile.

Es. Sposta i punti del viso sulla linea di perimetro ad essi più vicina ed evita di muoverli lungo il perimetro
stesso.

Questo è valido per tutti i punti, ad eccezione dei punti d'angolo. I punti sulle code degli occhi, o agli angoli
della bocca, devono essere posizionati in modo preciso.
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Non eccedere con l'uso degli slider

Spesso, con minimi cambiamenti si ottengono i migliori risultati.

Sfrutta gli slider giusto il necessario per ottenere il risultato che desideri.

Se eccedi nell'uso, il risultato potrebbe sembrare innaturale o artefatto.

Non usare gli slider per correggere piccole imperfezioni

Puoi evitare l'esigenza di eccedere nell'uso degli slider usando lo strumento di Ritocco  per pulire via punti
e piccole macchie. Un metodo sicuramente migliore rispetto al sovrautilizzo degli slider, i cui effetti si
ripercuoterebbero su tutta l'immagine.

Accertati che l'area della pelle sia definita in modo corretto

Portrait Professional individua automaticamente l' 'area di pelle' nella tua immagine. Ad ogni modo, è
possibile talvolta regolare la selezione automatica dell'area per ottenere i migliori risultati.

Usa gli strumenti Aumenta e Riduci  per intervenire su aree di pelle posizionate in maniera non adeguata.

1.3 Edizioni di Portrait Professional

Portrait Professional è disponibile in tre edizioni: Standard, Studio e Studio64. L'edizione Standard è studiata
per utilizzatori occasionali o fotografi amatori. L'edizione Studio  è destinata a veri appassionati o fotografi
professionisti.  Le versioni Studio e Studio64 hanno le stesse funzionalita'; la versione Studio, pero', è
un'applicazione a 32-bit mentre la versione Studio64 è un'applicazione a 64-bit. Cio' significa che la versione
Studio64 ha accesso a tutta la memoria del computer e quindi permette di lavorare con file di dimensioni
maggiori (fotografie molto grandi).

Questo manuale illustra entrambe le edizioni, con le funzioni disponibili solo per l'edizione Studio indicate in
questo modo:

Solo per Edizione Studio

Le principali differenze tra le due edizioni sono elencate qui sotto.

Supporto plugin Photoshop L'edizione Studio include un componente plug-in per
Photoshop, che permette di aprire un'immagine in Portrait
Professional Studio direttamente da Photoshop. Una volta
completato il miglioramento dell'immagine in Portrait
Professional, il risultato sarà automaticamente caricato su
Photoshop.

Lettura file immagini RAW , e file Adobe
DNG 

Solamente l'edizione Studio può leggere file di immagini
RAW e Adobe DNG.

Supporto 16 bit per campione di colore (48 bit
per pixel)

L'edizione Studio può lavorare con immagini contenenti 16
bit per campione di colore (48 bit per RGB pixel). L'edizione
Standard è limitata ad 8 bit per campione di colore (24 bit
per RGB pixel). Le immagini RAW contengono in genere più
di 8 bit per campione di colore - un numero di informazioni
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aggiuntive che possono così essere conservate
dall'edizione Studio. 

Contrariamente all'edizione Standard, l'edizione Studio può
leggere e scrivere file TIFF contenenti 16 bit per campione di
colore.

Il formato JPEG non supporta 16 bit per campione di colore.
Di conseguenza se un'immagine contenente 16 bit per
campione viene salvata come file JPEG, questo verrà
automaticamente convertito ad 8 bit per campione di colore.

Supporto profilo di colore Le immagini possono contenere extra informazioni sullo
"spazio di colore" utilizzato dai valori di colore RGB. Se
queste informazioni vengono ignorate, i colori che appaiono
sullo schermo e quelli sui file salvati potrebbero non essere
corretti. Solamente la versione Studio legge, scrive e applica
queste informazioni di spazio di colore.

Flusso di lavoro perfezionato quando si
migliorano immagini multiple

L'edizione Studio ti permette di selezionare più file usando il
file Sfoglia per creare una lista di file su cui lavorare. Questo
velocizza il tuo flusso di lavoro, poiché dopo aver migliorato
un'immagine potrai salvare il risultato e caricare la
successiva attraverso un singolo comando. 
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2 Guida Passo dopo Passo

Questa parte del manuale descrive le diverse fasi che dovete seguire per l’utilizzo di Portrait
Professional.

La fase più importante e’ quella della Manipolazione del Volto , dove potete visualizzare e
modificare l’immagine che volete ritoccare.

Molte delle altre fasi sono necessarie solo nel caso in cui il volto non sia stato trovato e
marcato automaticamente, o se volete manipolare diversi volti nella stessa immagine. 

2.1 Apri un'Immagine

La Schermata Iniziale di Portrait Professional

Quando si apre Portrait Professional, il programma partirà con la schermata iniziale:

Aprire un'immagine

Per aprire un'immagine da migliorare, puoi:

· Premere il pulsante Apri Immagine, oppure

· Selezionare il comando Apri nel menù File .

Questo aprirà la finestra di dialogo Apri File:

21
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Scorri fino al file che hai intenzione di  migliorare e premi il pulsante Apri.

Tipi di Immagini con cui il Portrait Professional può lavorare

In alternativa, clicca su uno degli esempi se vuoi provare l'applicazione e non hai nessuna immagine da
caricare a portata di mano.

2.2 Selezionare il Volto da Manipolare

Dopo aver aperto un’immagine, Portrait Professional la mostra nella fase Seleziona Volto.

Potete tornare a questa fase ogni volta che desiderate, dovete solamente usare il comando 
Manipola un Altro Volto in Questa Foto dal menù File, o premendo il pulsante Altri Volti nella
barra degli strumenti durante la fase Manipola Volto.

80
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Se è stato individuato solamente un volto, vi apparirà immediatamente la finestra di dialogo
Seleziona Genere , che vi condurrà alla fase Manipola Volto.

Nel caso in cui nella foto siano presenti diversi soggetti, le linee di contorno marcheranno tutti
i volti dell’immagine. Premete il pulsante Seleziona sul volto che volete modificare. Vi verrà
chiesto di selezionare il genere del soggetto, e così passerete alla fase dove potrete
controllare e aggiustare le linee di contorno dei volti.

Se dopo aver modificato un volto volete tornare indietro alla fase sopra indicata, vedrete
apparire sui volti un’ opzione extra: Aggiustare Linee di Contorno. Premete questo
pulsante e potrete modificare il contorno del volto. Il pulsante Seleziona vi porterà
nuovamente alla fase Manipola Volto.

Alcune volte può capitare che venga individuato un volto in una parte dell’immagine senza
soggetti. Dovete semplicemente ignorare queste linee di contorno e non selezionarle. Potete
eliminare le linee di contorno cliccando sulla croce che si trova in alto a destra rispetto al
volto.

Manipolare un volto che e’ stato individuato automaticamente

Se il volto che volete modificare non e’ stato individuato (quindi non sono apparse le linee di
contorno), premete il pulsante Nuovo Volto nel pannello di controllo. Questo vi permetterà di
localizzarlo manualmente.

Controllo per ogni volto

Per ogni volto individuato (automaticamente o manualmente), appariranno le linee di
contorno.

Una barra d’intestazione comparirà proprio sopra al volto; invece, sotto, il pulsante Seleziona
e Modifica le Linee di Contorno.

La barra d’intestazione sarà di colore blu per i volti non ancora modificati, e verde per quelli
gia’ modificati. 

Comando Descrizione
Indicatore/Selettore 
del Genere

Si trova a sinistra della barra d’intestazione. Clicca sul
simbolo del genere per far apparire il menù con cui scegliere il
genere del volto. Portrait Professional ha bisogno di sapere se
il soggetto e’ femminile o maschile per poter usare i canoni più
adeguati.

Pulsante di Eliminazione Si tratta di una croce posta a destra della barra d’intestazione.
Premete questo pulsante se volete cancellare tutti i dati
memorizzati da Portrait Professional sul volto.

Pulsante per la Selezione Seleziona i volti che verranno modificati. Appena selezionate
un volto, passerete alla fase Modifica le Linee di Contorno
dove potrete controllare e aggiustare i contorni. Se il volto e’
già stato modificato, premendo questo pulsante avrete la
possibilità di continuare a farlo

Pulsante per la Modifica delle
Linee del volto

Questo pulsante appare solamente quando il volto e’ stato già
modificato. Potrete effettuare cambiamenti nei lineamenti della
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fisionomia del volto. Si possono modificare i lineamenti anche
nella fase di Modifica Immagine , o se preferite potete
effettuare queste modifiche nella fase Aggiustamento Linee di
Contorno , nella quale vi verrà mostrate il modo in cui
posizionare le linee di contorno del viso rispetto ad
un’immagine di riferimento.

Simboli per i diversi Generi

ll genere verrà mostrato usando uno dei seguenti simboli:

Genere non selezionato. Se il pulsante di Selezione o Modifica delle Linee di Contorno
è stato premuto ma non e’ stato specificato il genere del soggetto, apparirà una finestra
di dialogo con la scritta Seleziona Genere , dandovi così la possibilità di selezionare
il genere prima di iniziare la manipolazione.

Genere Femminile

Genere Maschile

Genere Femminile, il volto appartiene ad una ragazza di circa 12 anni.

Genere Maschile, il volto è di un ragazzo giovane di circa 12 anni.

Quando il genere selezionato è di una persona giovane, i cambiamenti dei lineamenti del
volto sono limitati, generalmente ne sconsigliamo la modifica.

2.3 Localizzare Manualmente un Volto

Se il volto nella vostra immagine non è stato individuato automaticamente, dovrete farlo
manualmente.

Per individuare il volto manualmente, dovete premere il pulsante Nuovo Volto nella fase
Selezione Volto.

Vi verrà chiesto di selezionare il genere del volto da modificare, come descritto sotto.

Selezionare il genere

Portrait Professional ha bisogno di conoscere il genere del volto che verrà modificato. Questo
perché parte delle modifiche da fare sui volti dipende dal loro sesso, per ottenere i migliori
risultati possibili.

Premete il pulsante Donna se il volto e’ femminile (tasto rapido: f)

Premere il pulsante Uomo se il volto e’ maschile (tasto rapido: m)

Se si tratta del volto di un bambino (meno di 12 anni) premete il pulsante Bambino. Questo
migliorerà i risultati.

Portrait Professional vi condurrà automaticamente alla fase seguente non appena
selezionato il genere.
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Modificare solo la pelle

Se non c’è nessun volto nell’immagine, premete il pulsante Modifica Solo la Pelle. Appena
premuto il pulsante, vi verrà chiesto di selezionare un’area della pelle, dipingendola con il
pennello.

Questo comando va usato solamente se volete modificare la pelle quando non c’e’ nessun
volto nell’immagine. Se al contrario c’è un volto, otterrete risultati migliori se selezionate il
genere e poi posizionate le linee di contorno. Questo tipo di operazioneè più veloce poichè la
zona pelle viene selezionata automaticamente.

Se il pulsante Modifica Solo Pelle non appare, attivatelo usando il Pulsante Mostra “
Modifica Solo Pelle” spuntando la casella presente nelle Impostazioni Generali.  

Definizione dell’orientamento dell’immagine

Se la vostra immagine non è nella posizione desiderata, cliccate uno dei pulsanti presenti in
fondo al pannello di controllo. Questo permetterà alla vostra immagine di essere ruotata in
base alla direzione indicata dalla freccia.

Consigliamo di cambiare l’orientamento prima di selezionare il genere, perchè Portrait
Professional, dopo aver selezionato il genere, vi condurrà automaticamente alla fase
successiva.

Localizzare 5 elementi chiave dei lineamenti del viso

La fase seguente alla selezione del genere consiste nel localizzare 5 punti chiave della
fisionomia del viso.

60
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I 5 punti chiave sono:

Localizzare i punti della fisionomia

Cliccando su uno di questi punti, Portrait Professional vi porterà automaticamente a quello
successivo.

Vi verrà mostrato un esempio per farvi capire come posizionare correttamente i punti
sull’immagine.

Potrete modificare la posizione dei punti cliccando su uno di essi e spostandolo.

Sul cursore apparirà una piccola scritta che vi ricorda quale punto state localizzando. Queste
scritte possono essere rimosse, e potete farlo andando al pannello delle Impostazioni
Generali .60



Portrait Professional 1118

© 2013 Anthropics Technology Ltd.

Aumentare lo zoom

Per avere un aiuto per posizionare dei punti, potete tenere premuto il pulsante CMD per
avvicinarvi con lo zoom al cursore.

Profilo

Se il volto si trova di profilo, premete il pulsante Profilo che si trova in fondo al pannello di
controllo.

Se non siete sicuri se il volto sia di profilo o meno, guardate agli occhi. Se non potete vederne uno perché il
volto è leggermente girato, premete il pulsante Profilo.

Quando premete il pulsante Profilo, dovrete solamente localizzare un punto nell’occhio, uno
sul naso e uno sulla bocca.

Aggiustare le linee di contorno

Appena localizzati i 5 punti chiave dei lineamenti, Portrait Professional posizionerà
automaticamente le linee di contorno. Questa fase si chiama Aggiusta Linee di Contorno .

Se alcune delle linee non sono posizionate correttamente, aggiustatele muovendo i punti di
controllo. Prima di premere il pulsante Prossimo andate alla fase Modifica Volto  dove
potete visualizzare ed eventualmente modificare l’immagine.

2.4 Regola il Contorno

Visualizzazione e posizionamento contorno

La fase di perfezionamento delle Linee di Contorno mostrerà le linee intorno al volto,
dandovi la possibilità di aggiustarne la posizione.

Si giunge a questa fase dopo aver selezionato il genere di un volto che e’ stato localizzato
manualmente, o premendo il pulsante di Aggiustamento Linee di Contorno nella fase 
Seleziona Volto  , o in qualunque fase durante la localizzazione manuale . 

Se le linee di contorno non sono posizionate correttamente intorno ai lineamenti, dovranno
essere spostate e riposizionate. Un’immagine di esempio mostra come le linee di contorno
dovrebbero essere posizionate.
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Perfezionamento delle linee di contorno

Le linee di contorno appaiono di colore blu sopra la vostra immagine nell’area di lavoro.
Queste linee possono essere spostate utilizzando i punti di controllo.

I punti di controllo sono mostrati in modo diverso, a seconda di come sono stati impostati:

· I piccoli quadrati gialli- sono i punti posizionati automaticamente. Se si trovano
nella posizione sbagliata, dovrete muoverli manualmente e riposizionarli.

· I piccoli quadrati blu- sono i punti posizionati da voi.

· I cerchi verde chiaro- questi punti sono posizionati automaticamente in base a
dove si trovano gli altri. Il loro spostamento  è legato allo spostamento degli altri
punti. 

Ogni volta che spostate un punto di controllo, si trasformerà in un quadrato blu, per ricordarvi
che è già stato posizionato.

Per risultati migliori:

· Cercate di spostare solamente alcuni punti.

· Quando spostate i punti, cercate di farlo solo leggermente. Più tempo passate
ad aggiustare i punti, peggiori saranno i risultati.

· Iniziate spostando i punti posizionati automaticamente- i piccoli quadrati gialli e
blu. Cercate di non muovere invece i piccoli quadrati verdi.

Per aggiustare correttamente le linee intorno agli occhi e alla bocca, cliccate dentro il
rettangolo punteggiato per visualizzare piùda vicino i contorni. Cliccate nuovamente per
tornare all’immagine completa.
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Quando le linee di contorno sono posizionate correttamente ( o nel caso in cui non ci sia
bisogno di aggiustarle), premete la barra spaziatrice o il pulsante avanti.

Aggiustamento delle linee di contorno dell’iride e delle pupille

All’interno dell’occhio appaiono due cerchi. Quello più piccolo (di colore verde) dovrebbe
avere la stessa dimensione della pupilla (la parte nera al centro dell’occhio). Il cerchio più
ampio (di colore blu) si trova intorno all’iride (la parte colorata dell’occhio). Questi cerchi
vengono posizionati automaticamente, quindi la maggior parte delle volte non c’è bisogno di
modificarli.

Per spostare i cerchi, muovete i punti che si trovano al loro centro.

Per cambiare le dimensioni dei cerchi, modificate le linee di contorno dentro o fuori.

Se l’iride non e’ perfettamente circolare, potete muovere i quattro piccoli quadrati blu situati
sul contorno dell’iride formando un’ellisse.

Se il centro del’iride e quello della pupilla non combaciano, potete muovere la pupilla
indipendentemente dall’iride, cliccate nel centro della pupilla e muovetene il centro. Per
muovere l’iride e la pupilla insieme, cliccate al centro dell’iride o muovete il cursore lontano
dall’occhio e all’indietro.

Modificazione delle linee di contorno di ogni parte del volto

Per un’accurata visione della posizione delle linee di contorno, si può avvicinare con lo zoom
le parti fondamentali del volto. È sufficiente selezionare la casella Saltate la fase di zoom
progressivo quando si aggiustano le linee di contorno, che si trova nel pannello delle
Impostazioni Generali.

Con i profili questo avviene comunque, al di là delle impostazioni date, perchè la ricerca
automatica delle fisionomie non funziona con i volti di profilo.

Portrait Professional vi mostrerà ogni singola parte del volto, una alla volta, così che potrete
controllarle e, se necessario, aggiustare la posizione delle linee di contorno selezionate.

Le parti del volto sono elencate nel seguente ordine:

Occhio e sopracciglio sinistro

Le linee di contorno dell’occhio sinistro vengono definite automaticamente. Se non sono
posizionate correttamente intorno al sopracciglio, aggiustatele muovendo i punti di controllo.

A seconda della forma del sopracciglio, potrebbe essere difficile far combaciare le linee di
contorno. Non allarmatevi se non riuscite ad allinearli perfettamente. Anche se siete in grado
di far combaciare le linee quasi alla perfezione, probabilmente avrete un risultato migliore
muovendo i punti solo, leggermente anche se linee non combaciano esattamente.

Occhio e sopracciglio destro

Le considerazioni fatte a riguardo dell'occhio e del sopracciglio sinistro sono valide anche per l'occhio ed il
sopracciglio destro.
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Naso e Bocca

Quando arrivi in questa fase, apparirà il pannello Bocca Aperta o Chiusa?, ammesso che non sia stato
disattivato nelle Impostazioni Generali . Questo pannello presenta due pulsanti:

Bocca Aperta Premi questo pulsante se la bocca del viso che stai migliorando è aperta. Vedrai
quindi quattro linee tra gli angoli della bocca. Le due in alto dovrebbero essere
posizionate intorno al labbro superiore, mentre le due in basso intorno al labbro
inferiore. Se la linea inferiore del labbro superiore viene avvicinata fino a combaciare
con quella superiore del labbro inferiore, la prima sparirà per lasciare solamente il
punto di controllo al centro. A questo punto la bocca verrà considerata chiusa.

Bocca Chiusa Premi questo pulsante se la bocca è chiusa. Vedrai quindi tre linee tra gli angoli della
bocca. La linea al centro dovrebbe essere posizionata lungo la linea dove si incontrano
le labbra.

Se sei abituato a premere la barra di spazio per passare velocemente alla fase successiva, nota
che puoi anche usarla per chiudere la finestra di dialogo che chiede se la bocca è aperta o
chiusa. Se questo avviene, la bocca verrà considerata come aperta. Nel caso in cui questa sia in
realtà chiusa, puoi sia premere il pulsante Indietro e poi premere Avanti per far apparire di nuovo
il pannello, oppure puoi semplicemente unire le due linee centrali. 

Contorno Viso

Il contorno del viso non ha bisogno di essere tracciato in modo accurato. Così come per le altre parti, anche in
questo caso otterrai migliori risultati se muovi il meno possibile solo i punti strettamente necessari.

Evitate di spostare i punti delle linee di contorno del volto, muovendole soltanto verso il centro
o piuttosto allontanandole.

Una volta controllate tutte le parti del viso, premete il pulsante Prossimo per tonare
nuovamente a modificare la vostra immagine con Portrait Professional. Passerete alla fase 
Modifica Immagine , dove inizia il divertimento!

2.5 Migliora il Volto

Appena avete aggiustato le linee di contorno del volto nella vostra immagine, potrete iniziare
immediatamente a migliorarlo.

Visualizzazione risultato

Puoi scegliere se visualizzare l'immagine prima e dopo, una accanto all'altra, oppure se visualizzare solo
l'immagine migliorata su larga scala. Usa le etichette sopra le immagini per selezionare l'opzione che
preferisci.

Qualsiasi opzione usi, per controllare le modifiche puoi sempre passare dall'immagine migliorata ("dopo") a
quella originale ("prima"), tenendo premuto il tasto Invio.

Modifica risultato

Portrait Professional migliorerà la tua immagine automaticamente nel momento in cui raggiungi questa fase.
Guarda Slider Salvati  per capire come configuare questa impostazione di miglioramento predefinita.

Puoi modificare quanto un'immagine viene migliorata muovendo gli slider nel Pannello di Controllo .
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Gli slider sono raccolti in sezioni, che controllano vari aspetti del viso. Quando entri per la prima volta in questa
fase, le sezioni Controlli Modellamento Viso  e Controlli Pelle  sono aperte, al contrario delle altre che
invece rimangono chiuse. Le sezioni possono essere aperte o chiuse premendo il pulsante sulla relativa
barra di intestazione. Questa ha un piccolo triangolo accanto, che guarda giù se la sezione è aperta, o a destra
se è chiusa.

Prova a muovere lo slider Principale in ogni sezione per avere un'idea generale dell'effetto gestito da quella
sezione.

Gli slider secondari (più in basso) in ogni gruppo, ti permettono di avere un controllo più dettagliato sull'effetto.

Portrait Professional è dotato a sua volta di una serie di modelli di Slider Salvati , che includono valori
predefiniti degli slider per ottenere un particolare effetto. Puoi passarli in rassegna per vedere quanti tipi di
miglioramento sono possibili per la tua foto.

Risoluzione problemi

La maggior parte dei problemi che si manifestano sulle immagini migliorate sono causati o da uno o più
slider gestiti esageratamente, o dall'errata regolazione delle aree della pelle e dei capelli.

Usa i Pennelli  per sistemare le aree della pelle e dei capelli.

Altri problemi possono essere causati da un non corretto posizionamento intorno al volto
delle linee di controllo. Si può ovviare a ciò muovendo i punti di controllo nell’immagine
“prima”

Salvataggio risultati

Per salvare i risultati, seleziona il comando Salva dal Menu File  o dal pulsante Avanti in alto a sinistra. 

Questo ti permette di salvare l'immagine migliorata come file JPEG. L'opzione Salva Jpg/Tiff permette extra
opzioni di salvataggio per i file JPEG, ed anche il salvataggio di file TIFF.

Nel caso in cui volessi salvare tutte le impostazioni in modo da poter riaprire in seguito l'immagine e
continuare a regolare gli slider, seleziona il comando Salva Sessione dal Menu File. Verranno così salvate
l'immagine originale, tutte le posizioni dei punti, le aree di pelle e capelli e tutti i valori degli slider in un file
proprio del programma, con estensione ".pp".

2.6 Migliora Tutto il Corpo

Portrait Professional è progettato soprattutto per migliorare i ritratti.

Ad ogni modo, se la tua foto include anche altre parti del corpo, è possibile utilizzare gli strumenti di
miglioramento anche sulle altre parti di pelle visibili.

Tutto quello che devi fare è assicurarti che Portrait Professional individui quali parti della foto  riconoscere
come pelle. Operazione eseguibile usando gli strumenti area pelle, come descritto su Impostazioni Area Pelle

.

2.7 Modalità Plug-in

Utilizzo del Portrait Professional come Plug-in.
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Solo per Edizione Studio

L’Edizione Studio di Portrait Professional può essere usata in modalità plug-in. Questo
accade quando il Portrait Professonal è stato lanciato da un’altra applicazione (ad esempio
Photoshop) per manipolare un’immagine gestita da altre  applicazioni. Il Portrait
Professional si comporterà come un plug-in di un’altra applicazione.

Dopo aver installato correttamente il plug-in come spiegato nella Guida Installazione Plug-in
, sarete capaci di usare il Portrait Professional come plug-in di ogni programa di

manipolazione delle foto supportata.

Quando il Portrait Professional viene avviato come plug-in da un’altra applicazione,
l’immagine verrà automaticamente scaricata nel Portrait Professional, dove potrete
modificarla alla solita maniera. Quando sarete soddisfatti dei risultati, premete il pulsante 
Ritorna dal Plug-in sulla barra degli strumenti nella fase Modifica Volto . In questo modo
potrete chiudere Portrait Professional e riportare l’immagine modificata all’applicazione
originale.

Quando il Portrait Professional è in modalità plug-in, si verificano i seguenti cambiamenti:

· l’unico comando presente nel menù File  e’ Ritorna dal Plug-in.

· lo strumento di ritaglio  non e’ disponibile, poiché l’altra applicazione necessita che
l’immagine rimanga della stessa misura. 

Utilizzo di Portrait Professional da Photoshop

Quando il plug-in è stato installato, Portrait Professional comparirà tra i filtri di Photoshop. Nel
menù dei filtri di Photoshop, troverete una voce chiamata Anthropics, e da qui potete
accedere a Portrait Professional.

Il filtro di Portrait Professonal funziona come gli altri di Photoshop, e verrà applicato alla
selezione corrente (o all’intera area, se non c’e’ nessuna selezione). Quando selezionate il
filtro, l’immagine verrà automaticamente aperta con Portrait Professional.
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Posizione del Plug-in: Filtro>Anthropics>Portrait Professional

2.8 Foto di Gruppo

Lavorare su foto di gruppo

Se è presente più di un viso nella tua immagine, devi semplicemente completare tutto il processo di
miglioramento su un viso alla volta.

Se il rilevatore automatico di volti ha trovato più di un volto, andrete alla fase Seleziona Volto
 appena aperta l’immagine. Premete il pulsante Seleziona su uno dei volti da modificare

nella fase di Modifica Volto .

Per modificare un’altra immagine, ritornate alla fase Seleziona Volto :

· Premendo il pulsante Altro Volto nella barra degli strumenti nella fase di Modifica
Immagine , oppure

· Selezionate dal Menù File  il comando “Modifica un altro volto in Questa
Foto” ( tasto rapido CTRL+E)

Entrambe queste azioni vi condurranno alla fase Seleziona Volto , dove potrete iniziare la
manipolazione di un altro volto della foto, o selezionare un volto già elaborato, e continuarne
la manipolazione.

Potete ripetere questo processo ogni volta che volete, fino a che tutti i volti siano modificati.
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3 Riferimento

Questa sezione ti fornisce informazioni sui differenti comandi e controlli di menu in Portrait Professional.

Il Riferimento Menu Comandi descrive ogni comando del menu.

Il Riferimento Pannello Controlli  descrive ognuno dei controlli disponibili nella  fase di  ritocco immagine
.

Il Riferimento Finestre di Dialogo  descrive le principali finestre di dialogo usate nell'applicazione.

3.1 Riferimento Menu Comandi

Questi sono i comandi disponibili sulla barra di menu di Portrait Professional.

Menu File Comandi per aprire, salvare, stampare i file o modificare le impostazioni.

Menu Modifica Annulla e Ripristina.

Menu Corpo Intero Contiene un unico comando, Modifica Area Selezione Pelle.

Menu Visualizza Comandi per controllare la visualizzazione dell'immagine.

Menu Aiuto Comandi per inviare una richiesta di aiuto, controllare gli aggiornamenti, ricevere
assistenza o visualizzare informazioni riguardo al programma.

3.1.1 Menu File

Il menu File comprende i seguenti comandi:

Apri... Apre un file (vedi Tipologie di File Supportate ).

Se un file con modifiche non salvate è già aperto, ti verrà suggerito di salvare o
annullare le modifiche prima dell'apertura di un nuovo file.

Apri Gruppo... Solo per Edizione Studio  

Apre la finestra di dialogo Gruppo .

Salva e Apri Successivo Solo per Edizione Studio

Questo comando appare solo quando si lavora con un'immagine aperta dalla
finestra di dialogo Gruppo .

Salva l'immagine corrente e apre la successiva nel gruppo. 

La cartella in cui viene salvato il file e il formato del file, sono impostati dalla
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finestra di dialogo Gruppo .

Questo comando potrebbe apparire come "Apri Successivo" se un'immagine è
aperta dal gruppo e poi chiusa usando il comando File > Chiudi. 

Salva Salva il file corrente. Quando questo comando viene usato per la prima volta
dopo l'apertura di un file, le seguenti regole vengono applicate:

Se hai aperto un file JPEG, l'immagine migliorata sarà salvata come JPEG.

Se hai aperto un file TIFF o qualsiasi tipo di file RAW (Solo per Edizione Studio)
l'immagine migliorata sarà salvata come TIFF.

Se hai aperto un file di sessione (estensione .pp), il file di sessione verrà
salvato.

D'ora in avanti, questo comando salverà lo stesso tipo di file come è stato
salvato in precedenza.

Se questo comando è usato per la prima volta ed un nuovo file è stato creato,
apparirà un pannello Salva File per permetterti di scegliere dove salvare il file. 

Questo comando è disponibile solo nella fase di miglioramento immagine .

Salva Come... Salva il file corrente. Si comporta in modo simile al comando Salva, tranne per il
fatto che il pannello Salva File è sempre in vista per permetterti di scegliere dove
salvare il file.

Questo comando è disponibile solo nella fase di miglioramento immagine .

Salva Jpg/Tiff... Attiva il pannello Opzioni Salvataggio Immagine  per permetterti di  salvare
l'immagine migliorata come file JPEG o TIFF, e per impostare le opzioni salvate.

Una finestra di dialogo Salva File apparirà per permetterti di selezionare dove
salvare il file.

Questo comando è disponibile solo in fase di miglioramento immagine .

Salva Sessione Salva la sessione corrente in modo che potrà essere di nuovo aperta su Portrait
Professional.

I file di sessione Portrait Professional vengono salvati in un formato peculiare
che non può essere caricato da altre applicazioni. L'estensione del file è ".pp". Il
formato include sia l'immagine che tutte le posizioni dei punti, le impostazioni
degli slider e le maschere.

Questo comando è disponibile solo in fase di miglioramento immagine .

Chiudi Chiude la sessione corrente. In caso ci siano modifiche non salvate, ti verrà
suggerito di salvarle o annullarle.

Il comando Chiudi ti riporta alla schermata iniziale di Benvenuto .

Migliora Un Altro Viso In
Questa Foto

Vi porta alla fase Seleziona Volto,  cosi’ potrete modificare un altro
volto presente nella stessa immagine.
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Lo stesso comando è disponibile nella fase Manipola Volto  con il
pulsante Altri Volti

Impostazioni... Attiva la finestra di dialogo Impostazioni .

Nota: su Mac clicca "Preferenze" sotto la voce Portrait Professional.

Stampa... Attiva la finestra di dialogo Stampa, che ti permette di stampare l'immagine
migliorata.

Esci Chiude l'applicazione. In caso ci siano modifiche non salvate, ti verrà suggerito di
salvarle o annullarle.

Nota: su Mac clicca "Esci da Portrait Professional" sotto la voce Portrait
Professional.

Modalità Plug-in

Se l'applicazione è in modalità plug-in , l'unico comando nel menu File è Ritorna dal Plugin, grazie al
quale l mmagine modificata torna all pplicazione precedente e chiude Portrait
Professional. 

3.1.2 Menu Modifica

Il menu Modifica comprende i seguenti comandi:

Annulla Annulla le modifiche ai valori degli slider e quelle effettuate dai pennelli.

Questo significa poter sperimentare con differenti impostazioni salvate, o provare a
muovere qualsivoglia slider in totale sicurezza, poiche' sarà sempre possibile tornare
allo stadio precedente le modifiche se queste non sono ritenute soddisfacenti.

Questo comando è disponibile solo nella fase di miglioramento immagine .

Ripristina Ti permette di ripristinare l'effetto di un'azione che era stato annullato con il comando 
Annulla.

3.1.3 Menu Corpo Intero

Il menu Corpo Intero presenta il seguente comando:

Modifica Area Selezione Pelle... Questo comando attiva il pannello Selezione Pelle  per modificare
l'area di pelle selezionata.

Questo comando è disponibile solo nella fase di miglioramento
immagine .
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3.1.4 Menu Visualizza

Il menu Visualizza include i seguenti comandi:

Schermo Interno Adatta l'applicazione a tutto lo schermo, in modo da massimizzare l'area di lavoro.

Per riportare l'applicazione allo stato di finestra, seleziona di nuovo questo
comando.

Renderizzazione
Rapida

Aumenta la velocità di elaborazione dell'immagine.

Questo avviene riducendo il numero di pixels di lavoro nell'immagine migliorata.

Questa opzione è utile nel caso in cui gli slider siano particolarmente lenti sul tuo
computer.

Se l'immagine ritoccata ti sembra troppo sfocata, allora è preferibile che disattivi
quest'opzione.

N.B. Questa opzione si applica esclusivamente alla modalità di visualizzazione
dell'immagine all'interno del programma. La qualità del file salvato (File > Salva
Jpg/Tiff) non viene modificata.

3.1.5 Menu Aiuto

Il menu Aiuto comprende i seguenti comandi:

Contenuti Avvia l'aiuto online, mostrando la tavola dei contenuti.

Guida di Avvio Rapido Avvia l'aiuto online, mostrando la Guida Avvio Rapido .

Abbreviazioni Tastiera Avvia l'aiuto online, mostrando le Abbreviazioni Tastiera .

Riabilita Pop-up di Aiuto Attiva tutti i messaggi pop-up di aiuto che sono stati disabilitati. Questo
comando appare solamente se hai disattivato i messaggi pop-up di
aiuto.

Controlla Aggiornamenti... Avvia il  browser predefinito per mostrarti se hai o meno la versione più
recente di Portrait Professional.

Se sono presenti aggiornamenti disponibili, ti verranno forniti i relativi link
per scaricarli.

Supporto... Avvia il web browser predefinito per mostrarti le pagine di supporto di
Portrait Professional.

Puoi utilizzarlo per trovare risposte alle domande più comuni, o per
contattare il team di assistenza di Portrait Professional
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Informazioni su Portrait
Professional

Attiva il Pannello Informazioni, che mostra la versione di Portrait
Professional in tuo possesso.

Nota: su Mac, questo comando si trova nel menu' applicazioni di Portrait
Professional.

3.2 Riferimento Pannello di Controllo

Questa sezione descrive i controlli principali disponibili nella fase di miglioramento dell'immagine.

Panoramica Controlli Miglioramento Immagine

Zoom  - Permette di selezionare l'area dell'immagine che viene visualizzata

Slider Salvati  - Permette di impostare gruppi di slider su valori salvati

Controlli Slider  - Sono i comandi principali degli slider e permettono di avere la completa padronanza sul
modo in cui l'immagine viene migliorata

Questi comandi sono raccolti nei seguenti gruppi:

· Controlli Modellamento Viso  - Permettono di gestire come viene modellato il viso

· Controlli Pelle  - Permettono di gestire come vengono migliorata la pelle

· Controlli Occhi  - Permettono di gestire come vengono migliorati gli occhi

· Controlli Bocca e Naso  - Permettono di gestire come viene migliorati la bocca, le labbra e il naso

· Controlli Capelli  - Permettono di gestire come vengono migliorati i capelli
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· Controlli Luminosità Pelle  - Permettono di regolare la  quantità di luce sulla pelle

· Controlli Immagine  - Controlli che influiscono su tutta l'immagine, come luminosità/contrasto e
ritaglio 

Foto Originale - Mostra l'immagine ("Prima") originale

Foto Migliorata - Mostra l'immagine ("Dopo") migliorata

Visualizzazione Controlli

Le principali sezioni nel pannello dei controlli (in alto sulla destra) possono essere aperte o chiuse cliccando
sui pulsanti a capo di ognuna. Questi pulsanti hanno al fianco un piccolo triangolo che punta verso il basso
quando la sezione è aperta, o verso destra quando è chiusa.

Ridimensionamento Controlli

Il pannello dei controlli può essere allargato o ristretto muovendo il bordo destro del pannello stesso.

A loro volta, i gruppi principali all'interno del pannello possono essere ridimensionati muovendo lo spazio tra
essi.

Posizionamento e spostamento controlli

Il pannello può essere spostato (e reso così finestra indipendente) cliccando due volte sulla barra di
intestazione.

Una volta tolto dalla posizione di base, può essere mosso liberamente sullo schermo.

Può in seguito essere riposizionato cliccando di nuovo due volte sulla barra di intestazione, o trascinandolo
sul bordo destro o sinistro della schermata principale.

Quando si trascina il pannello per riposizionarlo, nota che non è sufficiente spostare la finestra dei controlli sul
bordo destro o su quello sinistro della schermata principale, in quanto è il cursore che deve essere spostato
vicino ai bordi.

Visualizzazione immagine migliorata

Per impostazione predefinita, quando il software viene installato per la prima volta, l'immagine originale e
quella migliorata vengono mostrate una di fianco all'altra, come appare nella schermata qui sopra.

Le due etichette sopra le immagini determinano l'impaginazione della finestra di lavoro.

· Clicca sull'etichetta Visualizza Solo Dopo per avere sullo schermo solo l'immagine migliorata.

· Clicca sull'etichetta Visualizza Prima e Dopo per ritornare all'impaginazione con le immagini a confronto.

Alternare tra l'immagine originale e quella migliorata

Qualsiasi impaginazione tu abbia scelto, hai sempre la possibilità di prememere il tasto invio per passare
velocemente dalla visualizzazione dell'immagine migliorata a quella dell'immagine originale. L'immagine
originale viene mostrata  finché il tasto invio rimane premuto.

Ciò ti permette di passare dalla foto migliorata a quella originale, il ché è un ottimo modo per osservarne i
cambiamenti.

In alternativa, puoi tenere premuto il mouse sul pulsante sopra l'immagine, che dice Tieni premuto questo
pulsante (o il tasto invio) per visualizzare l'altra immagine.
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3.2.1 Controllo Zoom

Il Controllo Zoom è parte del pannello dei controlli nella fase di miglioramento della foto.

Permette di vedere quale area dell'immagine è visibile nella finestra di lavoro. Inoltre è provvisto di controlli che
ti permettono di allargare o restringere il campo visivo, o fare una panoramica della visualizzazione corrente.

La foto qui sopra mostra il Controllo Zoom.

L'intestazione Controllo Zoom comprende i seguenti comandi:

Pulsante Zoom Permette di riavvolgere il menu controllo Zoom in modo che solo l'Intestazione sia
visibile.

Cliccalo di nuovo per riaprire il menu controllo Zoom.

Slider Zoom Permette di avvicinare (scorrimento verso destra) o allontanare (scorrimento verso
sinistra).

 Pulsante "Adatta" Adatta la schermata in modo che tutta l'immagine sia visibile.

 Pulsante "Viso" Adatta la schermata solo sul viso. 

Pulsante "1:1" Configura la scala di zoom in modo che un pixel dell'immagine originale equivalga
ad uno dello schermo.

Pulsante Avvicina/
Allontana

Mostra un menu a tendina con una scala di rapporti di zoom possibili.

Il rapporto di zoom corrente è marcato con un segno.

I rapporti definiscono la relazione tra i pixel dell'immagine originale e quelli dello
schermo, come mostrato nei seguenti esempi:

· 4:1 significa che 4 pixel dello schermo sono riempiti da 1 pixel dell'immagine
(l'immagine è allargata con un fattore di 4).

· 1:4 significa che 1 pixel dello schermo è coperto da 4 pixel dell'immagine
(l'immagine è ristretta con un fattore di 4).
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Il riquadro di selezione nel Controllo Zoom può essere trascinato per effettuare manualmente una panoramica
dell'immagine.

Cliccare fuori dal rettangolo centrerà la visualizzazione sul punto cliccato.

Si può fare una panoramica e scorrere la visualizzazione manualmente anche selezionando lo strumento 
Scorrimento Manuale .

Ridimensionamento Controllo Zoom

L'intero pannello di controllo (incluso il Controllo Zoom) può essere allargato trascinandone il bordo destro.

Il Controllo Zoom può essere allungato o accorciato trascinando lo spazio tra il Controllo Zoom e il Controllo
Slider Salvati.

Abbreviazioni Tastiera

+ Avvicina.

- Allontana.

3.2.2 Slider Salvati

La funzione Slider Salvati ti permette di impostare velocemente i valori di più slider.

Premi un pulsante nel pannello di controllo Slider Salvati per impostare gli slider in modo che diano l'effetto
descritto dal proprio nome.

Quando Portrait Professional viene installato, è già fornito di una serie di Slider Salvati pronti per l'uso.
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Una delle impostazioni degli Slider Salvati è utilizzata per definire i valori iniziali degli slider quando un viso
viene migliorato. L'impostazione usata può variare a seconda che il viso sia maschile o femminile, ed è
indicata dal simbolo maschile o femminile come mostrato nella figura qui sopra. Per modificare quale
impostazione Slider Salvati è configurata come predefinita per i nuovi visi, usa la finestra di dialogo Gestione
Slider Salvati .

L'Intestazione Slider Salvati comprende i seguenti controlli:

Pulsante Slider Salvati Ti permette di richiudere il controllo Slider Salvati in modo tale che rimanga
visualizzata solo l'intestazione. Una volta chiuso, i controlli nella barra di
Intestazione Slider Salvati cambieranno in quelli descritti sotto.

Clicca di nuovo per estendere il controllo Slider Salvati.

"Pulsante Slider Salvati" Apre la finestra di dialogo Salva Slider . Questa ti permette di salvare i
valori correnti degli slider come una nuova impostazione Slider Salvati.

"Pulsante Gestione" Apre la finestra di dialogo Gestione Slider Salvati . Questa ti permette di
rinominare, riposizionare o cancellare gli Slider Salvati. Inoltre, ti consente
di modificare gli Slider Salvati come predefiniti maschili o femminili.

"Pulsante Aiuto" Apre la pagina di aiuto.

Nota: ogni impostazione di Slider Salvati non coinvolge necessariamente tutti gli slider. Questo significa che
se selezioni un'impostazione di Slider Salvati, e poi un'altra, e poi riselezioni la prima, non riporterai
necessariamente tutti gli slider agli stessi valori che avevano dopo avere selezionato la prima impostazione la
prima volta. Ciò accade perché ogni slider condizionato dalla seconda impostazione, ma non dalla prima, non
sarà riportato indietro.

Il controllo Slider Salvati chiuso

Quando il controllo Slider Salvati viene chiuso premendo il Pulsante Slider Salvati, ha questo aspetto:

Il Pulsante Slider Salvati e il Pulsante Gestione sono sostituiti da un Pulsante Selezione Slider Salvati, che ti
permette di selezionare un'impostazione di Slider Salvati anche se il controllo è stato chiuso.

Quando premi sul Pulsante Selezione Slider Salvati, apparirà un menu a discesa contenente tutti gli Slider
Salvati. Clicca su uno di questi per configurare gli slider sui valori di quell'impostazione.

Ridimensionare il controllo Slider Salvati

L'intero pannello di controllo (incluso il controllo Slider Salvati) può essere ingrandito trascinandone il bordo
destro.

Il controllo Slider Salvati può essere allungato o accorciato trascinando lo spazio tra gli Slider Salvati e il
Controllo Principale degli slider.
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3.2.3 Controlli Slider

Gli Slider costituiscono il modo principale attraverso cui gestire il miglioramento di un'immagine.

Gli Sliders non hanno alcun effetto se posizionati su 0, mentre gli effetti aumentano se
vengono spostati verso destra(o verso sinistra, se il punto 0 è al centro). 

Per riportare il cursore a 0, basta fare due volte click sullo slider.

Sezioni di Slider

Gli slider sono organizzati in un certo numero di sezioni.

Controlli Modellamento Viso Rimodella finemente il viso per abbellirne i lineamenti.

Controlli per miglioramento
Pelle

Migliora l'aspetto della pelle.

Include anche strumenti per la rifinitura di aree che Portrait Professional
considera come pelle.

Controlli Occhi Migliora l'aspetto degli occhi.

Include anche un'opzione per abilitare la rimozione occhi-rossi.

Controlli Bocca e Naso Migliora l'aspetto della bocca e naso.

Controlli Colorazione Pelle Modifica il colore della pelle.

Controlli Schiarimento Pelle Modifica l’illuminazione sulla pelle

Controlli Capelli Migliora l'aspetto dei capelli.

Include anche strumenti per la rifinitura di aree che Portrait Professional
considera come capelli.

Controlli Immagine Controlla vari aspetti dell'immagine complessiva, come la luminosità e
il contrasto.

Include anche uno strumento che permette di ritagliare l'immagine.

Per prevenire confusione sullo schermo, ogni sezione può essere aperta o chiusa cliccando sul suo titolo. La
freccia accanto al titolo punta a destra quando la sezione è chiusa, mentre punta in basso quando è aperta.

Ogni sezione può inoltre essere attivata o disattivata premendo il pulsante attivo/disattivo alla destra del nome
della sezione. Quando una sezione è disattivata, non ha effetto sull'immagine. Questo può essere utile per
vedere quale effetto viene determinato da una particolare sezione.
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Organizzazione Slider

Gli slider seguono un'organizzazione gerarchica.

Ogni sezione ha uno Slider Principale che controlla tutti gli altri slider nella sezione stessa. Questo ti permette
di vedere come i controlli in quella sezione influiscono sull'immagine.

Al di sotto di ogni slider principale c'è una gerarchia di slider per il controllo fine sul miglioramento.

Se uno slider ha più sub-slider dipendenti, allora l'etichetta dello slider verrà visualizzata come un pulsante
con un triangolo sulla sinistra del titolo. Premi questo pulsante per aprire i sub-slider.

Quando muovi uno slider che comprende dei sub-slider, anche questi si muoveranno di conseguenza.

Quando muovi un sub-slider, vedrai muoversi anche lo slider di riferimento, ma ad un'ampiezza minore.
Questo perché lo slider di riferimento mostra sempre una media bilanciata degli slider da lui dipendenti. In
questo modo fornisce un'indicazione generale dei valori dei sui sub-slider anche quando questi sono chiusi.

Usare gli Slider

Ogni slider controlla gli effetti descritti dalla sua etichetta.

Per la maggior parte degli slider, l'effetto aumenta se lo slider viene mosso verso destra, mentre diminuisce
se viene mosso verso sinistra. Fanno eccezione que gli slider che ammettono valori negativi e hanno il valore
di 0 al centro. In questo caso, occorre allontanare lo slider dal centro per aumentare l'effetto o riavvicinarlo al
centro per diminuirlo .

A seconda di come trascini uno slider, puoi vedere quale sia il suo effetto, in quanto l'immagine viene
aggiornata in tempo reale.

Se lo slider è a 0, allora l'effetto che controlla non apporterà alcun cambiamento all'immagine.

Gli slider con valore 0 al centro tendono a "scattare" verso 0, cioe' ad assumere valore 0 ogni volta che
vengono posizionati nelle sue vicinanze. Se vuoi posizionare lo slider su un valore vicino a 0, tieni premuto il
tasto CTRL per evitare che "scatti" automaticamente sullo 0. 

Puoi anche cambiare la posizione dello slider non trascinandolo ma cliccando sul suo valore numerico ed
usando il controllo su/giù, oppure digitando direttamente il valore.

Per capire qual è la funzione propria di ogni singolo slider, passaci sopra con il mouse.

3.2.4 Controlli Modellamento Viso

Portrait Professional è l'unico software di ritocco fotografico che ti dà la capacità di rimodellare finemente ed
abbellire i lineamenti del viso, con il semplice movimento degli slider. 

Alcuni  ritengono che questa peculiare funzione di Portrait Professional, di modificare cioè la forma del viso,
sia inappropriata o eccessiva per il miglioramento di una foto. Si può decidere di lasciare gli slider al valore di
0. In questo modo Portrait Professional non intaccherà la fisionomia del soggetto. 

Ad ogni modo, prima di escludere questo effetto considerandolo una "finzione", ti invitiamo a provarlo - rimarrai
impressionato/a da come a volte anche una sottile definizione dei tratti può portare ad un sostanziale
miglioramento del soggetto. Il consiglio che ti diamo è quello di intervenire solo leggermente - giusto quanto
basta per dare al viso un aspetto più asciutto o come se fosse stato fotografato in una giornata
particolarmente favorevole.
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Slider

Controllo Principale Questo slider è connesso con gli altri relativi alla
manipolazione del volto e le sue parti. Quando si
muove questo slider, gli altri si sposteranno di
conseguenza. Gli slider che non sono connessi con
quello principale sono quelli che lavorano meglio in
alcuni aspetti specifici, come ad esrmpio l’aumento
delle labbra o l’ingrandimento occhi.

Forma del Volto Migliora la forma del viso. Premendo il pulsante Forma
Viso si aprono i seguenti sotto-slider:

Fronte Migliora la forma del capo.

Mandibola Regola la forma della mandibola.

Naso Migliora la forma del naso. Clicca il pulsante Naso per accedere
ai relativi sub-slider:

Accorcia Naso         Accorcia (o allunga) il naso modificando la
dimensione della testa.

Prolabio    Accorcia (o allunga) il prolabio, la striscia di pelle che
va dal labbro superiore all'attaccatura del naso, modificando la
lunghezza di quest'ultimo.

Punta Sottile            Restringe (o allarga) la punta del naso.

Naso Sottile              Restringe (o allarga) l'intero naso.

Occhi Modifica contemporaneamente la posizione e la forma di occhi e
sopracciglia. Clicca il pulsante Occhi per accedere ai relativi
sub-slider:

Occhio Sinistro       Migliora la forma dell'occhio sinistro (utile
per pareggiarne forma e dimensione).

Occhio Destro         Migliora la forma dell'occhio destro.

Strabismo                 Allontana (o avvicina) gli occhi.

Forma sopracciglia  Migliora la forma delle sopracciglie. Clicca
sul pulsante Forma sopracciglia per accedere ai due sub-slider
che ti permettono di intervenire su una sola sopracciglia alla
volta.

Forma Bocca Migliora la conformazione complessiva della bocca. Premi il
pulsante Forma Bocca per accedere ai relativi sub-slider:

Sorriso Modifica la forma della bocca,
come se il soggetto 
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stesse sorridendo

Labbro Superiore Migliora la forma del labbro superiore.

Labbro Inferiore Migliora la forma del labbro inferiore.

Espressione Cambia l'espressione della bocca.

Linea Labbra Attenua la linea tra i denti e le labbra
per prevenire un effetto seghettato
che potrebe verificarsi in fase di
modellamento del viso. Questo sub-
slider non appare quando la bocca
del soggetto è chiusa.

Ingrandisce le Labbra Aumenta il volume delle labbra. Premendo il pulsante 
Ingrandire Labbra si apriranno due sotto-sliders che
permettono di controllare separatamente il labbro
superiore e quello inferiore 

Ingrandimento degli occhi Ingrandisce (o rimpicciolisce) gli occhi del soggetto.
Premendo il pulsante Ingrandire Occhi si aprono due
sotto-sliders che permettono di ingrandire
separatamente l’occhio destro o quello sinistro.

Collo Snello Snellisce il collo.

Correzione della Forma degli Occhiali

Se il soggetto indossa gli occhiali, si potrebbe verificare una distorsione della loro forma,
dovuta alle modifiche intorno agli occhi effettuate con Portrait Professional. Per ovviare a
questo problema si può usare il comando Correzione Forma Occhiali, che ridurrà la
distorsione della forma degli occhiali.

Esempio
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3.2.5 Controllo miglioramento della pelle

Controllo miglioramento della pelle ti permette di rimuovere o ridurre nel dettaglio rughe, macchie e altre
imperfezioni, sempre mantendo l'originale consistenza della pelle. Tutto questo può essere fatto con il
semplice movimento degli slider. 

Puoi anche ridurre le ombre e l’effetto pelle lucida.

Portrait Professional riconosce automaticamente l'area da trattare come pelle, ma puoi ottenere risultati più
accurati controllando e sistemando l'area pelle.

Slider

Controllo Principale Questo slider è connesso agli altri in questa sezione, poiché
produce un miglioramento generale della pelle. Gli altri slider si
muovono insieme a questo

Imperfezioni Rimuove finemente arrossature e riduce piccoli accumuli nell'area di
pelle.

          Prima                      Dopo
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Rughe De-enfatizza le rughe nell'area di pelle rendendole più lievi e fini.

          Prima                      Dopo

Sfumature Fine Dissolve macchie scure e rughe leggere nell'area di pelle.  

Prima    Dopo

Pori Rimuove i pori e addolcisce l'area di pelle donandole un effetto morbido.

Prima    Dopo

Pelle lucida Attenua le zone di pelle lucida, facendole diventare piu’ rosee.

Prima Dopo

Contorno Occhi Riduce le borse sotto agli occhi e le “zampe di gallina”, le
rughette che possono comparire in fondo agli occhi.
Utilizzando il comando Contorno Occhi si aprono anche i
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sotto-slider che permettono di controllare in modo indipendente
vari fattori:

Illuminare le borse Riduce la voluminosità delle
borse sotto gli occhi
conferendo loro luminosità.
Quando si preme il pulsante 
Illumina le borse si aprono
due sotto slider per modificare
Indipendentemente l’occhio
destro e quello sinistro.

Ridurre le borse Riduce le borse sotto agli occhi
illuminando il colore della pelle
della zona circostante. Quando
si preme il pulsante Ridurre le
borse si aprono due sotto
slider per  modificare
Indipendentemente l’occhio
destro e quello sinistro

Attenuare le zampe di
gallina

Addolcisce l’area intorno
all’occhio destro e quello
sinistro, dove ci sono le zampe
di gallina. Quando si preme il
pulsante  Attenuare le zampe
di gallina si aprono due sotto
slider per modificare
Indipendentemente l’occhio
destro e quello sinistro

Miglioramento della
pelle

Rimuove maggiori imperfezioni dalla pelle senza perdere i dettagli.

Prima    Dopo

Tonalita’ Questo slider cerca di bilanciare l’effetto risultante
dall’eliminazione dei difetti, evitando che le zone scure si
mischiano con quelle chiare. 
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Pattern - Tessuto In fase di correzione della pelle, gestisce quanto tessuto viene aggiunto. Il
ché avviene principalmente mediante le pennellate. Ingrandisci
l'immagine per vedere i cambiamenti apportati al tessuto della pelle.
Premi il pulsante Tessuto per accere ai relativi sub-slider:

 Luminosità Regola, con accuratezza, la luminosita' del tessuto.

 Saturazione Regola, con accuratezza, la saturazione del tessuto.

 Dimensione Allarga o restringe l'area pelle.

Tipi di pelle

Si può scegliere all’interno di una campionatura di diversi tipi di pelle. Per vedere la differenza
delle varie tramature, basta fare zoom sulla pelle.   

Rimozione Macchie

Per impostazione di base, Portrait Professional rimuove automaticamente le macchie.

Ciò che tu puoi fare è regolare il grado della rimozione utilizzando il menu a tendina Rimozione Macchie, posto
in cima ai Controlli Pelle.

Se pensi che Portrait Professional non abbia rimosso la macchia, puoi ritoccare manualmente l'area in
questione usando il pennello Ritocco.

Se Portrait Professional ha rimosso una macchia che in realtà volevi mantenere, puoi ripristinarla
manualmente usando il pennello Ripristino.

Maggiori informazioni sull'uso dei pennelli .

Esempio

Le immagini sottostanti di Prima e Dopo mostrano un esempio di come Portrait Professional rimuova
automaticamente le rughe:
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3.2.6 Controlli Occhi

Portrait Professional può automaticamente ravvivare, sbiancare e definire gli occhi. I controlli Occhi ti
permettono di regolare con esattezza gli effetti desiderati, compreso il cambiamento del colore.

Slider

Controllo Principale Questo slider è collegato con gli altri sliders di questa
sezione, e consente di effettuare una modifica generale degli
occhi.

Quando questo slider viene spostato, gli altri si spostano a
loro volta.

Occhi Bianchi Sbianca la parte bianca degli occhi. L'area sulla quale viene applicato

l'effetto è definita dallo slider Schiarimento Area .

Lo sbiancamento rimuove ogni colore dal bianco degli occhi lasciando
un'ombreggiatura di grigio quando lo slider è al massimo.  Clicca sul
pulsante Sbiancamento Occhi per accedere ai due sub-slider che ti
permettono di intervenire su un occhio alla volta.

Illuminazione Occhi Illumina la parte bianca degli occhi, aumentandone la brillantezza senza
perderne il colore.   Clicca sul pulsante Brillantezza Occhi per accedere
ai due sub-slider che ti permettono di intervenire su un occhio alla volta.

Illuminazione area Modifica la zona dell’occhio che verrà sottoposto all’azione
degli slider Occhi Bianchi e Illuminazione Occhi.

Premendo il pulsante Illuminazione Area si apriranno due
sliders che permettono di modificare 

separatamente l’occhio sinistro e quello destro.

Definizione Occhi  Regola la definizione degli occhi.

 Clicca sul pulsante Definizione Occhi per accere ai relativi sub-slider,
che ti permettono di regolare la definizione delle varie parti dell'occhio:
  

 Ciglia Superiori Sx           Definisce le ciglia superiori dell'occhio

sinistro.

 Ciglia Inferiori Sx             Definisce le ciglia inferiori dell'occhio sinistro.

 Occhio Sinistro                Definisce l'occhio sinistro.

 Area Ciglia Sinistro         Regola l'area sulla quale vengono applicati gli

effetti di Definizione Occhi per l'occhio sinistro.
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 Ciglia Superiore Dx        Definisce le ciglia superiori dell'occhio destro.

 Ciglia Inferiore Dx          Definisce le ciglia inferiori dell'occhio destro.

 Occhio Destro                Definisce l'occhio destro.

 Area Ciglia Destro         Regola l'area sulla quale vengono applicati gli

effetti di Definizione Occhi per l'occhio destro.   

Definizione Sopracciglia  Regola la definizione delle sopracciglia. Clicca sul pulsante Definizione
Sopracciglia per accere ai due sub-slider che ti permettono di
intervenire su un sopracciglio alla volta.

Colore Iride Occhi Attiva i controlli per modificare il colore degli occhi. Clicca sul pulsante 
Colore Iride Occhi per accedere ai relativi sub-slider, che ti permettono
di modificare il colore delle iridi:

Quantità del Sfumatura 

Quando lo slider è a 0, il colore degli occhi resta invariato (gli slider
Colore e Intensità sono disattivati).

Quando lo slider è a 100, il colore degli occhio è definito per intero dagli
slider Colore e Intensità. Per valori inferiori a 100, il colore degli occhi è
definito in parte dal colore  originale e in parte dagli slider Colore e
Intensità.

Se lo slider si trova a 0 e uno degli slider Colore o Intensità viene
attivato, il valore dello slider passa automaticamente a 100.

Clicca sul pulsante Quantità del sfumatura per accere ai relativi sub-
slider che ti permettono di intervenire su un occhio alla volta.

Colore    Definisce il colore dell'occhio (quando lo slider Quantità del
cambiamento ha un valore diverso da 0). Clicca sul pulsante Colore per
accere ai relativi sub-slider che ti permettono di intervenire su un occhio
alla volta.

Intensità    Definisce l'intensità del colore degli occhi. Clicca sul
pulsante Intensità per accere ai relativi sub-slider che ti permettono di
intervenire su un occhio alla volta.

Se hai modificato il colore degli occhi usando questi controlli, puoi
selezionare la casella Colore Occhi Originale per riportare gli occhi al
loro colore originario. Quando questa casella è attiva, gli slider di
Saturazione e Tonalità del colore degli occhi vengono ignorati. 

Luminosità Iride Illumina o scurisce l'iride (l'area colorata dell'occhio). Clicca sul
pulsante Luminosità Iride per accere ai relativi sub-slider che ti
permettono di intervenire su un occhio alla volta.
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Scurimento Pupille Scurisce le pupille (l'area nera al centro dell'occhio). Clicca sul pulsante
Scurimento Pupille per accere ai relativi sub-slider che ti permettono di
intervenire su un occhio alla volta.

Riflesso Pupille Questo slider scurisce le pupille per rimuovere eventuali
riflessi. Si può utilizzare insieme ad Aggiungere 

Riflesso dal menù a tendina per aggiungere un nuovo
riflesso.

Premendo il pulsante Rimuovere Riflesso Pupilla si
aprono due slider che permettono di rimuovere il riflesso 

 dalla pupilla destra e da quella sinistra indipendentemente. 

Rotazione Riflesso Se hai aggiunto un riflesso nell’occhio usando dal menù a
tendina il comando Aggiungere Riflesso, con il 

Pulsante Rotazione Riflesso si apre una slider che
permette di muoverlo.

Se non hai aggiunto nessun riflesso, questi slider non
avranno nessun effetto.

Occhio Sinistro Oriz. Muove il riflesso dell’occhio
sinistro orizzontalmente
(sinistra&destra)

Occhio sinistro Vert. Muove il riflesso dell’occhio
sinistro Verticalmente
(sopra&sotto)

Occhio destro Oriz. Muove il riflesso dell’occhio
destro orizzontalmente.

Occhio destro Vert. Muove il riflesso dell’occhio
destro verticalmente.

Rimozione Occhi Rossi

Se nella tua foto appaiono gli "occhi rossi" (a causa dei riflessi del flash), questi possono essere rimossi
automaticamente selezionando la casella Rimozione Occhi Rossi in cima ai controlli Occhi.

Aggiungi Riflesso

Puoi selezionare tra una serie di riflessi di luce da aggiungere agli occhi. 

Esempio

Le immagini Prima e Dopo qui sotto mostrano come gli occhi del soggetto siano stati sbiancati e definiti in
modo automatico da Portrait Professional.
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3.2.7 Controlli Bocca e Naso

Portrait Professional sbianca i denti e migliora il colore delle labbra automaticamente. I controlli Bocca e Naso
ti permettono di regolare con precisione questi effetti per avere esattamente il look che desideri.

Slider

Controllo Principale Questo slider è collegato ad alcune delle altre slider di questa
sezione che apportano un miglioramento generale della bocca
e del naso. Quando questa slider si muove, anche le altre si 
spostano a loro volta.

Sbiancamento Denti Rimuove ogni macchia dai denti . L'area di influenza è controllata
dallo slider Sbiancamento Area. Questo controllo non viene visualizzato se
la bocca è chiusa.

Brillantezza Denti Fa diventare i denti brillanti. L'area di influenza è controllata dallo slider
Sbiancamento Area. Questo controllo non viene visualizzato se la bocca è
chiusa.

Area Denti Bianchi Modifica l'area influenzata dagli Slider di Sbiancamento e Luminosità Denti.
Questo controllo non viene visualizzato se la bocca è chiusa.

Saturazione Labbra Rende le labbra più colorite.

Scurimento Labbra Muovere questo slider verso destra per scurire le labbra, o verso sinistra
per schiarirle.

Contrasto Labbra Aumenta il contrasto nell'area labbra, dando alle stesse un impatto
maggiore.

Tonalità Labbra Modifica il colore delle labbra.

Inumidisce Labbra Aggiunge lucentezza alle labbra.

Definizione Bocca Definisce meglio le linee di contorno e i dettagli della bocca.
Premete il pulsante Definizione Bocca per aprire gli slider che
permettono di controllare il grado di miglioramento da applicare
alle diverse parti della bocca in modo indipendente.
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Labbro Superiore Definisce solo il labbro superiore.

Linea Labbra Definisce solo i denti.

Labbro Inferiore Definisce solo il labbro inferiore.

Contrasto Narici Aumenta il contrasto delle ombre intorno al naso per farlo
risaltare

Esempio

  

3.2.8 Controllo del colore della pelle

Il controllo del colore della pelle vi permetterà di cambiare selettivamente il colore della pelle.

Portrait Professional determina la zona della pelle automaticamente, ma si possono ottenere
risultati migliori se controllate e aggiustate personalmente la zona della pelle 

Sliders

Bilanciamento
automatico del
bianco

Aggiustate manualmente il colore della pelle per rimuovere le
macchie. Se la pelle ha un buon bilancio del bianco, questo slider
non avrà nessun effetto.

Per il controllo manuale del bilanciamento del bianco della pelle,
usate gli slider della Temperatura e della Tinta.

Esposizione
Automatica

Regola automaticamente l’esposizione della pelle. Se la zona della
pelle ha una buona esposizione, questo slider non avrà nessun
effetto.

Per il controllo manuale dell’esposizione, usate lo slider
dell’Esposizione..

Temperatura Aggiusta il colore della pelle per rimuovere ogni alone dovuto alla
temperatura (rosso-blu)

Tinta Aggiusta il colore della pelle per eliminare ogni tinta (verde-viola)
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Esposizione Aggiusta l’esposizione della pelle.

Colore Guance Aggiunge colore alle guance. Premendo il pulsante Colore Guance
aprirete i seguenti slider:

Saturazione
guance

Questo slider è direttamente collegato allo slider 
Colorazione Guance e  fornisce lo stesso
effetto. Premendo il pulsante Saturazione
Guance si aprono  due slider che permettono di
aggiungere colore alla guancia sinistra o a quella
destra in maniera indipendente.

Tonalita’ Guance Cambia la tonalità del colore delle guance.
Premendo il pulsante 
Tonalita’ Guance si aprono due slider che
permettono di cambiare
 la tonalità della guancia destra e di quella
sinistra indipendentemente.

Equilibrio

Tonalita’

Bilancia il colore della pelle. Se il colore della pelle è della stessa
tonalità, questo slider non avrà nessun effetto.

Prima Dopo

Abbronzatura Fornisce alla pelle un aspetto abbronzato. Premendo il pulsante 
Abbronzatura si aprono i seguenti sliders

Saturate Da’ alla pelle un colore piu’ ricco.

Scurire Scurisce leggermente il colore della pelle.

3.2.9 Controlli Luminosità Pelle

Portrait Professional permette di migliorare la luminosità del viso del soggetto attraverso semplici controlli.
Puoi sistemare i riflessi, le ombre e il contrasto.

Slider

Zigomi Definisce maggiormente gli zigomi. Premendo il pulsante Zigomi si
aprono due slider che permettono di modificare lo zigomo destro e
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quello sinistro separatamente

Ombre Riduce le zone scure nell'area di pelle selezionata.

Luce Corregge un'illuminazione non ottimale solo sul viso.

Contrasto Regola il contrasto dell'illuminazione sulla pelle selezionata.

Riflessi Scurisce le zone luminose nell'area di pelle selezionata.

Nota: questi slider agiscono soltanto sulle parti dell’immagine che si trovano nella zona pelle
. Premi il pulsante guarda/modifica la zona pelle  per cambiarne l’area.

Esempio

  

3.2.10 Controlli Capelli

Portrait Professional ti permette di migliorare i capelli del soggetto, semplicemente muovendo gli slider. Nota
per favore che prima di fare ciò, è molto importante che l'area dei capelli sia impostata in modo corretto –
guarda Area Capelli più sotto.

Slider

Livello di
ricolorazione
capelli

Controlla la quantità di colore da applicare ai capelli.

Il colore e’ stabilito selezionandone uno dal menù a tendina
Ricolorazione Capelli.

Questa slider verrà automaticamente regolata a 100 se si trovava a 0
quando e’ stato scelto il colore dal menù Ricolorazione Capelli .

Luminosità Aumenta o diminiscuisce la luminosita' dei capelli.
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Tinta Rende i capelli più chiari o più scuri.

Saturazione Modifica il colore dei capelli. Valori alti aumentano la componente rossa, valori
bassi aumentano la componente grigia.

Intensità Regola l'intensita' del colore dei capelli. 

Modalità Acconciatura Capelli

Ulteriori comandi si trovano nella Modalità Acconciatura Capelli. Clicca su Vai a Modalità Acconciatura Capelli
per accedere agli slider.

Riempimento Ombre Capelli Riempie le aree scure tra i capelli (causate da un
ammassamento degli stessi) per un effetto più omogeneo.

 
          Prima                        Dopo

Clicca sul pulsante Riempimento Ombre Capelli per accedere
ai relativi  sub-slider, che ti permettono di regolare con
accuratezza il riempimento:

Luminosità Ombra Controlla il grado di luminosità delle ombre schiarite dallo
slider Riempimento Ombre Capelli.

Trama Ombra Controlla il grado di consistenza delle ombre schiarite dallo
slider Riempimento Ombre Capelli.

Capelli Morbidi Liscia i capelli arruffati. 

 
          Prima                        Dopo

Clicca sul pulsante Capelli Morbidi per accedere ai relativi  sub-
slider, che ti permettono di regolare con accuratezza
l'addolcimento:
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Grado di Morbidezza Modifica il grado con cui lo slider di Capelli Morbidi rende i
capelli più o meno morbidi.

Premi il pulsante OK per uscire dalla Modalità Acconciatura Capelli.

3.2.11 Controlli Immagine

Questi controlli agiscono sull'intera immagine e ti permettono di verificarne l'aspetto generale, attraverso la
gestione di comandi come il contrasto e la tonalità del colore.

Puoi anche ritagliare l'immagine usando lo strumento Ritaglia .

Slider

Bilanciamento
Automatico del
Bianco

Aggiusta automaticamente il colore dell’intera immagine per rimuovere
ogni tipo di alone, utilizzando il colore della pelle come punto di
riferimento.

Se il colore della pelle è già naturale, questo slider avra’ poco o nessun
effetto.

Esposizione
Automatica

Aggiusta automaticamente l’esposizione dell’immagine, usando la
pelle come punto di riferimento.

Se la pelle ha già una buona esposizione, questo slider avrà poco o
nessun effetto.

Temperatura Aggiusta il colore dell’intera immagine per rimuovere le sfumature
(rosso-blu)

Tinta Aggiusta il colore dell’intera immagine per rimuovere le tinte (verdi-
viola)

Esposizione Aggiusta l’ esposizione (brillantezza) di tutta l’immagine

Premendo il pulsante Esposizione si aprono i seguenti slider, che
garantiscono un diverso controllo dell’esposizione:

Preservazione
colori Esposizione

Aggiusta l’esposizione complessiva (brillantezza)
dell’immagine e ne previene 
il cambiamento di colore

Brillantezza Aggiusta la Brillantezza dell’intera immagine. Questo controllo ha un
buon effetto sui mezzi toni dell’immagine.

Contrasto
Intelligente

Incrementa o diminuisce il contrasto dell’intera immagine in modo da
far emergere i dettagli, pur lasciando la brillantezza e il colore intatti.

Premendo il pulsante Contrasti intelligenti, si aprono altri slider che

76



Portrait Professional 1154

© 2013 Anthropics Technology Ltd.

consentono di effettuare altre modifiche al contrasto:

Contrasto Aggiusta il contrasto dell’intera immagine usando
una tecnica semplice e basilare. 

Preservazione del
Colore Contrasto

Aggiusta il contrasto dell’intera immagine in modo
da prevenire il cambiamento di colore che un altro
slider può causare.

Vivideza Aggiusta la Vividezza dell’intera foto, incrementando la vividezza, i
colori della foto saranno più intensi. Diminuendo la vividezza i colori
saranno meno intensi( piu’ grigi)

Premendo il pulsante Vividezza si aprono altri slider che forniscono
effetti simili:

Saturazione Aggiusta la saturazione del colore (intensità)
dell’intera immagine. Vividezza e Saturazione
danno effetti simili, la differenza sta nel fatto che 
la Vividezza ha meno effetto della Saturazione
su colori che sono meno intensi. Nessuno dei
due slider ha effetto su bianco, nero e grigio.

Curva dei Toni La Curva dei Toni viene usata per cambiare la luminosità di
un’immagine in modo tale da consentire diversi tipi di cambiamenti
nelle aree che hanno gradi di luminosità differenti. La Curva dei Toni
è collegata ad altri slider che producono un effetto di luminosità diffusa,
se vengono spostati verso destra, o un effetto scuro, se vengono
spostati verso sinistra.

Premendo il pulsante Curva dei Toni si aprono i seguenti slider:

Fissa flash Sottolinea I dettagli smorzando le luci più vivide
Evidenziare Aumenta o diminuisce la luminosità delle luci più

vivide
Luce Aumenta o diminuisce la luminosità delle aree

luminose
Scuro Aumenta o diminuisce la luminosità delle aree più

scure
Ombre Aumenta o diminuisce la luminosità delle ombre
Nero Sottolinea le aree scure
Riempe Ombre Illumina le aree scure dell’immagine, per far

emergere i dettagli in ombra

Esempio
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3.2.12 Strumenti Area Pelle

Portrait Professional identifica automaticamente le aree della fotografia in cui è presente della pelle.  Gli effetti
degli slider Pelle e Luminosita' Pelle vengono applicati su quest'area. In alcuni casi può capitare che
l'identificazione non sia del tutto corretta, per cui è consigliato controllare di persona ed apportare le eventuali
modifiche necessarie prima di iniziare il lavoro su quest'area.   

Per controllare e modificare la zona della pelle, clicca sul pulsante Guarda/Correggi la Zona
della Pelle che si trova in alto ad ogni sezione che contiene gli slider per la modifica della
pelle. Queste sezioni sono: Levigamento Pelle , Colorazione Pelle  e Schiarimento
pellle.

In questo modo si avrà accesso agli strumenti per la selezione della zona della pelle. La zona
della pelle verrà mostrata coperta da un colore blu. Se questo colore non consente la visione
della zona della pelle, si può scegliere un altro colore dalla lista Colore dal menu a tendina 
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Puoi modificare a mano l'area pelle usando i Pennelli Area Pelle . 

In alternativa, Portrait Professional può ricalcolare l'area pelle in maniera automatica. Per farlo, clicca su 
Ricalcola Area Pelle (questo apre la finestra Area Pelle). 

Clicca OK per tornare agli slider di controllo.

3.2.13 Strumenti Area Capelli

Portrait Professional identifica automaticamente le aree della fotografia in cui sono presenti capelli.  Gli effetti
dei relativi slider vengono applicati su quest'area. E' importante che l'area capelli sia individuata con
accuratezza per ottenere il massimo dagli slider capelli.

Puoi visualizzare e modificare l'area capelli dalla sezione Controlli Capelli (clicca su Mostra Controlli Capelli
 per accedervi).

Clicca quindi il pulsante Visualizza/Modifica Area Capelli (sopra l'elenco degli slider capelli) per accedere agli
strumenti di selezione dell'area capelli. L'area identificata come capelli viene visualizzata con una patina
traslucida color fucsia. Se hai problemi a visualizzare la fotografia sottostante puoi cambiare il colore della
patina usando il menu a tendina.

Puoi modificare a mano l'area capelli usando i Pennelli Area Capelli .

Premi OK per tornare agli slider di controllo.
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3.3 Riferimento Finestre di Dialogo

Questa sezione descrive le finestre di dialogo in Portrait Professional.

Opzioni Salvataggio Immagine Opzioni di salvataggio di un' immagine come file JPEG o TIFF.

Impostazioni Generali Impostazioni che controllano le varie parti di Portrait Professional. 

Configurazione Colori Impostazioni Profili di Colore (Solo per Edizione Studio).

Lingua Impostazioni Lingua Interfaccia Utente (solo per versioni multi-
lingue).

Salva Slider Opzione utilizzata per salvare i valori correnti degli slider.

Gestione Slider Salvati Per gestire le impostazioni degli Slider Salvati (rinomina, riordina o
cancella).

Selezione Pelle Ti permette di configurare e ricalcolare l'area della pelle.
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3.3.1 Seleziona Genere

Questa finestra compare se il genere del volto non e’ stato selezionato.

Premi il pulsante Femminile o Maschile per inserire il genere ( o Ragazza o Ragazzo se il
volto e’ di una persona giovane). Fatto questo, Portrait Professional potrà passare alla
prossima fase.

Se non si vuole selezionare il genere del soggetto e si desidera cancellare quest’azione, si 
torna alla fase precedente.

Se la finestra appare automaticamente quando è stato trovato un unico volto, comparirà il
pulsante per il Rilascio Linee di Contorno, nel caso in cui il volto non sia stato trovato
correttamente.

La finestra può apparire nei seguenti casi:

· dopo aver caricato un’immagine , quando è stato trovato un solo volto.

· Quando si preme il pulsante Seleziona su un volto nella fase Seleziona Volto , se il
genere non e’ stato ancora selezionato.

12
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3.3.2 Opzioni Salva Immagine

Quando salvi un'immagine usando il comando di menu File > Salva Jpg/Tiff, apparirà la finestra di dialogo
Opzioni Salvataggio Immagine.

Questa ti permette di selezionare con quale tipologia di file salvare l'immagine, se come JPEG o TIFF.

Formato JPEG

Se selezioni JPEG, puoi controllare la qualità dell'immagine salvata. Il vantaggio di scegliere un'immagine a
bassa qualità è quello di avere un file di dimensioni ridotte. JPEG è di solito la migliore opzione se non hai
intenzione di effettuare ulteriori modifiche dopo che l'immagine è stata salvata.

Formato TIFF

Salvare un'immagine come TIFF dà come risultato un file più grande rispetto al JPEG. Tuttavia, TIFF registra
l'immagine così com'è, senza mai perdere qualità. Questa è la migliore opzione se intendi riaprire l'immagine
in seguito su altri programmi di ritocco.

Le immagini TIFF possono essere registrate sia come non compresse, sia come compresse con la minima
perdita di informazioni. L'impostazione raccomandata è per il salvataggio compresso. L'unica ragione per non
selezionare la compressione a perdita minima, sarebbe quella di salvarle perché poi si intende riaprire il file
TIFF in un'altra applicazione che non supporta la compressione TIFF (sebbene sia improbabile che i moderni
software non supportino questo formato).

Solo per l’Edizione Studio  i TIFF possono salvare 8 o 16 bits per campione di colore.
Se stai lavorando con un’immagine a 16 bps, avrai la possibilità di salvare il TIFF ad 8 o 16
bps. Si usa un’immagine a 16bps se l’impostazione del Colore  è regolata su Usa Sempre
16 bps, o se si scarica un’immagine che contiene 16 bps e la vostra impostazione del colore
è regolata su Usate il Bit dell’Immagine.

9
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3.3.3 Impostazioni

Per aprire questa finestra di dialogo, seleziona File > Impostazioni dal menu comandi.

Generale Impostazioni Generali.

Colore Configurazione Colori.

Lingua Impostazioni Lingua.

Plugin Permette di installare il filtro plug-in per Photoshop che a sua volta permette a Portrait
Professional di essere usato come filtro da Photoshop.

3.3.3.1 Impostazioni Generali

Per cambiare queste impostazioni, selezionate dal comando menu  PortraitProfessional >
Preferences 
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Impostazioni Salvataggio File

Non Sovrascrivere il File Originale - seleziona questa casella e, quando salverai un'immagine, Portrait
Professional creerà un nome file predefinito differente da quello originale.

Aggiungi Suffisso al Nome File - con l'opzione sovradescritta attiva, il nome file per i file salvati sarà lo stesso
del vecchio con l'aggiunta del testo inserito qui. Di base, il suffisso aggiunto è "_pp" così, per esempio, se un
file chiamato immagine.jpg viene caricato, allora il file salvato predefinito sarà immagine_pp.jpg
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Impostazioni File Recenti

Non Salvare La Lista Di File Recenti Quando L'Applicazione Viene Chiusa - seleziona questa casella e non
verrà salvata nessuna storia di file aperti quando l'applicazione viene chiusa.

Impostazioni Interfaccia Utente

Usa Interfaccia di Stile Nero - seleziona questa casella per usare lo schema di colore scuro, o deselezionala
per uno stile Mac  più convenzionale.

Mostra Esempi Su Schermata Iniziale - seleziona questa casella per vedere le immagini di esempio nella
Schermata di Benvenuto.

Trova Automaticamente Volti nelle Immagini- seleziona questa casella per far selezionare
automaticamente i volti nell’immagine aperta. Se questa casella non è selezionata, bisognerà
trovare manualmente i volti nelle foto, prima di iniziarne la modificazione. 

Mostra Scritte Accanto Al Cursore - seleziona questa casella e, quando sarai in fase di posizionamento dei
5 punti principali sul viso, il cursore avrà un testo aggiuntivo accanto ai punti, per aiutarti. 

Salta la fase di zoom progressivo quando si aggiustano le Linee di Contorno-
seleziona questa casella per saltare la fase in cui dove l’immagine viene ingrandita vicino
all’occhio sinistro, all’occhio destro, al naso e alla bocca dopo che i 5 punti chiave sono stati
localizzati. Nota: questo non avviene nei profili ( quando il volto è in posizione laterale)

Usa Constrizione della posizione dei Punti – seleziona questa casella per forzare la
posizione dei punti in una certa maniera quando vengono spostati. Questo può aiutare ad
evitare che alcuni punti vengano selezionati nella posizione sbagliata, probabilmente gli utenti
con esperienza avranno risultati migliori se questo controllo non viene attivato. 

Visualizza finestra Bocca Aperto o Chiusa - seleziona questa casella e, in fase di regolazione dei punti sulla
bocca, Portrait Professional ti chiederà se questa è aperta o chiusa. Nota che anche con quest'opzione attiva,
puoi premere la barra di spazio per confermare che la bocca è aperta e passare alla fase successiva di
spostamento dei punti. Dopo aver fatto ciò, se la bocca è in realtà chiusa, congiungi semplicemente i punti
della labbra perché questi si uniscano a formare una bocca chiusa. 

Mostra pulsante "Migliora Solo Pelle": seleziona questa casella per far apparire il pulsante "Migliora Solo
Pelle" nella schermata iniziale di selezione del genere del soggetto.

Mostra Suggerimenti: deseleziona questa casella per disattivare i suggerimenti che appaiono quando passi
con il mouse sopra un comando.

Impostazioni Aggiornamenti

Controllo Aggiornamenti Automatico: quando questa casella è selezionata, Portrait Professional controlla
periodicamente se è disponibile una nuova versione. In caso sia disponibile, un pulsante aggiorna comprare
nella schermata di benvenuto inziale. Clicca sul pulsante per avviare il browser predefinito e avere
informazioni sull'aggiornamento disponibile.

Impostazioni Modalità Plug-in

Modalità Auto Plug-in - [Solo per EdizioneStudio] Se la Modalità Auto Plug-in è impostata, Portrait
Professional entrerà in modalità plug-in nel caso in cui un percorso sia specificato sulla linea di comando
quando l'applicazione viene lanciata.
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3.3.3.2 Configurazione Colori

Solo per Edizione Studio

Per aprire questa finestra di dialogo, seleziona File > Impostazioni dal menu comandi e poi Tabella Colori.

9
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La gestione del colore permette di accertarsi che i colori visualizzati sul proprio monitor siano il più fedeli
possibile a come dovrebbero apparire nella realtà.

In più, permette di configurare quale profilo di colore Portrait Professional usa al suo interno. Operazione che
coinvolge la gamma dei colori, ovvero la varietà di colori che può essere rappresentata.

Per la massima velocità di esecuzione, seleziona l'opzione "Elevata Performance". Questa permetterà a
Portrait Professional di ottimizzare l'uso dei profili di colore per lo schermo quando è usato interattivamente. A
prescindere da questa impostazione, quando salverai i file verrà usato il tuo profilo di lavoro scelto. 

Puoi anche configurare l'intensità del colore usata da Portrait Professional, ovvero il numero di bit utilizzati per
rappresentare ciascun campione di colore.

Ogni pixel consiste di 3 campioni di colore (rosso, verde e blu), per cui:

· 8 bit per campione di colore corrispondono a 24 bit per pixel.

· 16 bit per campione di colore corrispondono a 48 bit per pixel.

Nota: questa finestra di dialogo è disponibile solo per la versione Studio di Portrait Professional. La versione
standard non ha l'opzione di gestione del colore e lavora solo con 8 bit per campione di colore. Può quindi
capitare che, visualizzando le immagini con la versione standard, i colori sullo schermo non siano
estremamente accurati . Essi preservano, comunque, i loro profili di colore:  l'immagine elaborata e salvata
con la versione standard di Portrait Professional mantiene i colori dell'immagine originale, anche se non sono
visualizzabili. Quando si apre l'immagine con un programma che gestisce i colori in maniera diversa, i colori
originari vengono ripristinati.  

La gestione del colore: come funziona

Quando l'opzione di gestione colore è selezionata, Portrait Professional fa in modo che i colori vengano
visualizzati correttamente sullo schermo, cioè che rispettino il profilo di colore specificato sia dall'immagine
che dal monitor. Per ottenere il massimo dalla gestione del colore è consigliato calibrare il monitor invece di
usare il profilo definito dal produttore. 

Immagina, ad esempio, un'immagine salvata con due profili diversi (RGB e Adobe 1998). In questo caso,  i
colori dei due file appariranno un pò diversi quando l'opzione di gestione del colore è deselezionata. Attivando
l'opzione, invece, i colori appariranno uguali. Per essere precisi, i colori appariranno leggermente diversi
anche quando l'opzione di gestione è attiva, poiche' alcuni colori fuori gamma vanno persi durante la creazione
di un file ed esistono errori di arrotondamento generati da diversi tipi di conversioni dei profili di colore nel
momento in cui l'immagine è mostrata. Queste differenze, comunque, sono molto sottili e difficili da notare.

E' buona norma usare il profilo Adobe (1998) quando si lavora con immagini destinate alla stampa e il profilo
RGB quando si manipolano fotografie al computer. In ogni caso è sconsigliato convertire le immagini da un
profilo all'altro (a meno che non sia strettamente necessario). Durante il processo di conversione, infatti, può
capitare che alcuni colori escano dalla gamma e vadano persi (perché, ad esempio, non possono più essere
rappresentati nel nuovo spazio di colore), o che gli errori di arrotondamento producano un mescolarsi di colori
sulle aree della foto a tinte più uniformi.
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3.3.3.3 Impostazioni Lingua

Per aprire questa finestra di dialogo, seleziona File > Impostazioni dal menu comandi e poi scegli Lingua.

Se selezioni l'opzione Automatico, la lingua verrà automaticamente impostata su quella attualmente in uso dal
tuo computer (se supporta quella lingua), altrimenti verrà selezionata la lingua Inglese.

3.3.3.4 Plugin

Solo per Edizione Studio

Per aprire questa finestra di dialogo, seleziona File > Impostazioni dal menu comandi e poi la Tabella Plugin.

9
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Questa finestra ti permette di installare Portrait Professional come plug-in di Photoshop/Aperture.

L’opzione di usare Portrait Professional come plug-in di Photoshop ti è stata offerta nel momento in cui hai
installato il programma sul computer. Questa finestra ti permette di rilanciare il plug-in nel caso avessi scelto
di non installare il plug-in fin da subito o se, nel frattempo, hai installato una versione più recente dii
Photoshop/Aperture.

Il plug-in di installazione identifica automaticamente la versione (o le versioni) di Photoshop/Aperture presenti
sul tuo computer. Seleziona il riquadro accanto al nome di ciascuna applicazione per la quale vuoi installare
Portrait Professional come plug-in.

Puoi selezionare manualmente il folder nel quale installare il plug-in. Questa opzione è utile se intendi
installarlo su applicazioni diverse da Photoshop/Aperture  (compatibili con Portrait Professional) o se il folder
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di Photoshop/Aperture  non viene identificato automaticamente.

Utilizzo di Portrait Professional da Photoshop

Dopo l'installazione, Portrait Professional compare tra i filtri di Photoshop. Nel menu Filtri di Photoshop, clicca
sul sotto-menu Antrophics e, al suo interno, seleziona Portrait Professional.

 Il funzionamento di Portrait Professional è analogo a quello degli altri filtri di Photoshop: il filtro, cioè, viene
applicato sull’area selezionata (o sull’intera immagine in caso non sia stata selezionata un’area specifica) del
livello sul quale si sta lavorando. Quando selezioni il filtro Portrait Professional, l’immagine viene riaperta con
Portrait Professional (che funziona, in questo caso, in modalità plug-in ). Dopo aver elaborato l’immagine,
clicca Salva e Chiudi nel menu File di Portrait Professional. In questo modo Portrait Professional verrà chiuso
e l’immagine, elaborata, verrà trasferita nuovamente a Photoshop.

3.3.4 Salva Slider

Per aprire questa finestra, premi il pulsante Salva Slider nei Controlli Slider Salvati.

Inserisci un nome e, una volta premuto OK, i valori correnti degli slider saranno registrati con gli altri Slider
Salvati.

Se inserisci il nome in un'impostazione Slider Salvati già esistente, questo verrà sostituito.

Di base, tutti i valori degli slider sono salvati. Nel caso tu intenda salvare solo un sottogruppo di slider, premi il
pulsante Seleziona Slider Da Salvare. Questo allargherà la finestra di dialogo come mostrato qui sotto.
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Clicca sulla casella accanto ad ogni slider per passare di volta in volta tra salvato (selezionato) e non salvato
(deselezionato).

Se clicchi sulla casella di uno slider che ha dei sub-slider, tutti questi verrano impostati sullo stesso valore.
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3.3.5 Gestisci Slider Salvati

Per aprire questa finestra di dialogo, premi il pulsante Gestione nei Controlli Slider Salvati  .

Questa finestra di dialogo mostra le impostazioni di tutti gli Slider Salvati, eccetto il preimpostato "Ripristina
Immagine Originale", che non può essere modificato.

Per rinominare le impostazioni di Slider Salvati, fai doppio click sul nome nella lista e poi digita il nuovo nome.

Per ri-ordinare gli Slider Salvati, puoi trascinarli in una nuova posizione nella lista.

Per cancellare le impostazioni di Slider Salvati, clicca su quello che vuoi cancellare per selezionarlo e poi
premi il pulsante Cancella.

Per impostare una certa configurazione di Slider Salvati come predefinita quando lavori su un nuovo viso,
clicca su quella che desideri e poi premi il pulsante Femminile Predefinito o Maschile Predefinito.

3.3.6 Selezione Pelle

Per aprire questa finestra di dialogo, premi il pulsante Modifica Area Pelle alla base della sezione Controlli
Pelle, o seleziona il comando Modifica Area Selezione Pelle dal menu Corpo Intero .
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La casella Mostra Area Pelle ti permette di visualizzare o nascondere l'area della pelle come una patina blu
sopra l'immagine. Questa funzione equivale a quella della casella Mostra Area Pelle nella sezione Controlli
Pelle .

Per ricalcolare l'area della pelle, seleziona una delle opzioni e premi il pulsante Ricalcolo.

Le opzioni controllano quanto a fondo Portrait Professional ricercherà le tonalità di pelle al di sotto del viso.

Un'alternativa per ricalcolare l'area della pelle è utilizzare gli strumenti Aumenta e Riduci nella sezione
Controlli Pelle.

Nota: se ricalcoli l'area della pelle, tutti i cambiamenti fatti in precedenza utilizzando uno qualsiasi degli
strumenti nella sezione Controlli Pelle, verranno persi.

3.3.7 Gruppo

Solo per Edizione Studio

Per aprire questa finestra di dialogo, seleziona File > Apri Gruppo... dal menu comandi.

41

9



Riferimento 71

© 2013 Anthropics Technology Ltd.

Questa finestra di dialogo  ti permette di impostare una lista di file su cui lavorare. Puoi anche impostare le
opzioni di salvataggio da utilizzare quando ogni file viene salvato.

Aggiungere File

Per aggiungere file al gruppo, premi il pulsante Aggiungi File. Questo apre una finestra di dialogo che puoi
usare per selezionare i file da aggiungere.

I file del gruppo sono visibili nella lista in cima alla finestra. 

Usare Lista Gruppo

Quando premi il pulsante OK, le tue modifiche vengono salvate e il primo file che non è stato già completato
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nella lista verrà aperto.

Quando hai terminato di migliorare quell'immagine, seleziona il comando Salva e Apri Successivo dal menu
File . Questo salverà il file corrente usando le opzioni selezionate e poi aprirà automaticamente il prossimo
file nella lista.

Se apri di nuovo la finestra di dialogo Gruppo, vedrai un un'icona accanto al file che hai appena completato. 

Le seguenti icone possono apparire accanto ai file nella lista:

In Attesa - il file sta aspettando di essere eseguito

Completato - il file è stato elaborato e salvato

Fallito - Impossibile aprire il file

Saltato - il file è stato chiuso senza salvare le modifiche

Puoi ripristinare lo status di un file su "In Attesa" cliccando col tasto destro sul file e selezionando Ripristina
Stato dal menu a tendina. 

Una volta completati tutti i file nel gruppo, premi il pulsante Rimuovi Completati per rimuoverli dalla lista. 

I file nel Gruppo e le sue impostazioni vengono salvati quando Portrait Professional viene chiuso, in modo da
poter continuare a lavorare su di essi quando Portrait Professional viene riaperto. 

Riorganizzare i File

I file vengono aperti nell'ordine mostrato in questa lista. Se desideri riordinarli, seleziona uno o più file nella
lista e premi il pulsante Muovi in Alto o Muovi in Basso. 

Puoi anche rimuovere gli oggetti selezionati premendo il pulsante Rimuovi. Nota che in questo caso i file
verranno solamente rimossi dalla lista, non cancellati dal disco. 

Per selezionare più di un file nella lista, tieni premuto il tasto CTRL quando selezioni un altro file. In alternativa,
puoi tenere premuto il tasto SHIFT per aggiungere tutti i file compresi tra quello corrente e quello su cui hai
cliccato. 

Opzioni di Salvataggio

I file vengono salvati nel formato mostrato nella sezione Opzioni Salvataggio. Premi il pulsante Modifica per
aprire una finestra di dialogo che ti permette di cambiarne il formato. 

Se selezioni la casella Salva Anche Sessione, allora anche il file di sessione Portrait Professional
(estensione .pp) verrà salvato. IN questo modo verranno salvati l'immagine, le posizioni dei punti e i valori di
tutti gli slider. In questo modo potrai aprire un file di sessione per continuare a migliorare un'immagine senza
dover posizionare di nuovo i punti sul viso. Il file di sessione verrà salvato nella stessa cartella e con lo stesso
nome dell'immagine migliorata, ma con l'estensione .pp.  

Se l'opzione Salva nella Stessa Cartella del File Originale è selezionata, i file verranno salvati nella stessa
cartella del file originale. Se vuoi salvare le immagini migliorate in una cartella differente, deseleziona la
casella e inserisci un percorso nel campo Percorso Cartella. Puoi premere il pulsante Sfoglia per aprire una
finestra di dialogo che ti permette di selezionare una cartella in cui salvare.

L'immagine migliorata verrà salvata in un file con lo stesso nome del file originale. Se hai specificato un
suffisso da aggiungere alle Impostazioni Salvataggio File , questo verrà a sua volta aggiunto.
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3.4 Riferimento Strumenti

Questa sezione descrive gli strumenti disponibili in Portrait Professional.

Questi strumenti diventano accessibili in fase di miglioramento immagine  e funzionano nella schermata
dell'immagine migliorata ("Dopo").

Quando cambi strumento, cambi di conseguenza cosa accadrà se clicchi sulla schermata dell'immagine
migliorata.

Ogni strumento ha un proprio cursore di una certa forma, in questo modo potrai facilmente controllare quale
strumento viene selezionato.

Scorrimento Manuale Permette di scorrere la visuale sull'immagine. È impostato come predefinito
se nessun altro strumento viene selezionato.

Pennelli Ti permettono di intervenire sull'immagine migliorata per  ritoccare o
ripristinare macchie.

Pennelli di area Ti permettono di intervenire sull'immagine migliorata per rifinire aree di pelle
o capelli.

Ritaglia Permette di ritagliare l'immagine.

3.4.1 Selezione Manuale

Lo strumento di Scorrimento Manuale è disponibile nella fase di Miglioramento Immagine .

Lo Scorrimento Manuale è impostato come strumento predefinito quando nessun altro strumento viene
selezionato.

Per utilizzarlo, clicca sull'icona dello strumento e trascinalo nell'immagine migliorata per selezionare quale
parte dell'immagine rendere visibile.

Lo Scorrimento Manuale può essere usato come alternativa al Controllo Zoom .

Lo Scorrimento Manuale è l'unico strumento che funziona anche sull'immagine originale, se è stata impostata
la schermata a confronto.

3.4.2 Pennelli

I pennelli diventano disponibili nella fase di Miglioramento Immagine . Funzionano come dei pennelli veri:
posiziona il cursore sopra l'area che vuoi "dipingere" e poi, tenendo premuto il tasto sinistro del mouse,
evidenzia l'area da pitturare. 

Ci sono 2 tipi di pennelli. Questa pagina descrive il funzionamento dei pennelli tradizionali, che si usano per
modificare porzioni di pelle e capelli dopo averne migliorato l'aspetto.  I Pennelli di Area, invece, si usano per
definire le aree di pelle e capelli sulle quali applicare gli effetti. 

Esistono 6 differenti tipologie, che lavorano tutte in modo simile.
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Pennelli Ritocco e Ripristino

I seguenti pennelli sono accessibili dalla barra sopra la schermata principale di visualizzazione
dell'immagine.

Pennello Ritocco Usalo per correggere punti o macchie sulla pelle che non sono stati
eliminati automaticamente.

Pennello Ripristino Usalo per ridipingere sulla pelle punti che sono stati rimossi, ma che in
realtà vorresti mantenere.

Pennelli Pelle

I seguenti pennelli sono accessibili dai Controlli Pelle .

Espandi Maschera Pelle Ti permette di incrementare l'area che sarà trattata come pelle durante il
miglioramento.

Usalo per intervenire su aree della foto che risultano essere pelle, ma che
non sono state automaticamente riconosciute come tale.

Riduci Maschera Pelle Ti permette di correggere aree che non dovrebbero essere trattate come
pelle durante il miglioramento.

Usalo per intervenire su aree della foto che non sono pelle, ma che sono
state automaticamente riconosciute come tale.

Pennelli Capelli

I seguenti pennelli sono accessibili dal gruppo Controlli Capelli .

Aumenta Maschera Capelli Ti permette di incrementare l'area che sarà trattata come capelli durante il
miglioramento.

Usalo per intervenire su aree della foto che sono capelli, ma che non
sono state automaticamente riconosciute come tali.

Riduci Maschera Capelli Ti permette di correggere aree che non dovrebbero essere trattate come
capelli durante il miglioramento.

Usalo per intervenire su aree della foto che non sono capelli, ma che
sono state automaticamente riconosciute come tali.

Controlli Pennelli

Per selezionare un pennello, premi il relativo pulsante.

Premi nuovamente il pulsante per deselezionarlo (questo ti riporterà allo Scorrimento Manuale ).

I pennelli agiscono come pennelli veri. Puoi usarli per intervenire su un'area dell'immagine migliorata, sulla
quale verrà applicato l'effetto del relativo pennello.
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Per usare un pennello, premi il tasto sinistro del mouse mentre il cursore è sull'immagine migliorata, e poi
muovi il mouse tenendo il tasto premuto. Rilascia per conludere la pennellata. L'area su cui il cursore passa
nel momento in cui compi questa azione è l'area che hai "dipinto". 

Dimensione Pennello

La dimensione del pennello determina quanto grande sarà la sua area di influenza, la cui grandezza è
osservabile dalla dimensione del cursore a forma di cerchio.

Forza Pennello

La forza del pennello (opacità) controlla quanto intenso sarà l'effetto del segno del pennello. Un'opacità del
valore di 100 significa che ad ogni pennellata sarà applicato l'effetto completo. Per effettuare modifiche
graduali, puoi impostare un livello di opacità inferiore. 

Per esempio, se selezioni un'opacità del valore di 50 quando usi il Pennello di Ritocco, nel momento in cui
interverrai su una macchia verrà applicata solo la metà dell'effetto di completa rimozione della stessa. Se
rilasci il mouse e poi ripassi sopra la macchia, allora anche l'altro 50% verrà rimosso. Ciò ti permette di
calibrare gradualmente la rimozione della macchia, ma senza applicare un effetto totale che potrebbe
condizionare anche l'area circostante.

Quando un pennello viene selezionato, accanto al pulsante appariranno i controlli per definirne la dimensione
e l'intensità.

Pennello Annulla

Quando utilizzi qualsiasi pennello, l'ultima pennellata può essere annullata usando il comando Annulla dal 
Menu Modifica , o premendo Control-Z sulla tastiera. Ulteriori annullamenti elimineranno le pennellate
precedenti e altre azioni che hai eseguito, tornando indietro lungo la storia della sessione corrente. Dopo un
annullamento puoi anche ripristinare per tornare alla fase in cui eri premendo il comando Ripristina dal Menu
Modifica , o Control-Y.

Supporto Tavoletta

Portrait Professional supporta penna e tavoletta. Se le possiedi troverai in genere più facile usarle quando
disegni. Una tavoletta sensibile alla pressione ti garantirà inoltre maggiore controllo quando dipingi le aree. 

3.4.3 Pennelli di Area

I Pennelli di Area sono indispensabili per migliorare un'immagine perche' permettono di definire le aree in cui
si trovano la pelle e i capelli da ritoccare. Portrait Professional individua automaticamente le aree
dell'immagine che contengono pelle e capelli, ma in alcuni casi può capitare che l'identificazione non sia
corretta o soddisfacente. I Pennelli di Area permettono di correggere gli errori e definire in dettaglio l'area di
lavoro.

I Pennelli di Area sono "intelligenti" nel senso che individuano i bordi di ciascuna regione dell'immagine in
maniera automatica.

La posizione del Pennello di Area viene mostrata con due cerchi concentrici. Quando dipingi usando questo
strumento, il cerchio più interno, chiamato "radar", viene colorato normalmente. L'area compresa tra il cerchio
esterno e il radar, invece, viene colorata solo nei punti che hanno un colore simile a quello del radar.
Per colorare una superficie lungo un bordo, ad esempio, è sufficiente posizionare il radar al suo interno: il
Pennello di Area colorera' automaticamente la superficie fino al bordo, senza andare oltre (anche in caso il
cerchio esterno esca dal bordo stesso).
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Puoi bloccare la posizione del radar tenendo premuto il tasto ALT (è utile quando dipingi dettagli molto delicati,
come una ciocca di capelli).

Pennelli di Pelle

Usa i Controlli Pelle per visualizzare o modificare l'area pelle  (clicca su Mostra Controlli Pelle per accedervi,
poi clicca su Visualizza/Modifica Area Pelle)

Espandi Area Pelle Amplia l'area trattata come pelle. 

Passa questo pennello sopra le aree della foto che contengono pelle, ma non
sono state identificate come tali dal rilevatore automatico.

Riduci Area Pelle Riduce l'area trattata come pelle

Passa questo pennello sopra le aree della foto che non contengono pelle, ma
sono state erroneamente identificate come tali dal rilevatore automatico.

Controlli Capelli

Usa i Controlli Capelli per visualizzare e modificare l'area capelli (clicca su Mostra Controlli Capelli per
accedervi, poi clicca su Visualizza/Modifica Area)

Espandi Area Capelli Amplia l'area trattata come capelli. 

Passa questo pennello sopra le aree della foto che contengono capelli, ma non
sono state identificate come tali dal rilevatore automatico.

Riduci Area Capelli Riduce l'area trattata comecapelli.

Passa questo pennello sopra le aree della foto che non contengono capelli, ma
sono state erroneamente identificate come tali dal rilevatore automatico.

3.4.4 Ritaglio

Il comando Ritaglio è disponibile nella fase di Miglioramento Immagine .

Per selezionarlo, premi il relativo pulsante nella sezione Controlli Immagine .

Il comando Ritaglio è usato per inquadrare e definire l'area dell'immagine che si intende utilizzare per il ritratto
finale. Potresti ad esempio usufruirne per eliminare gli elementi non importanti, in modo che l'immagine sia
focalizzata solo sulla persona. Ad ogni modo quando ritagli in realtà non perdi nulla dell'immagine, cambi
solamente l'area visualizzata e puoi sempre tornare indietro per rimodificare l'area di ritaglio se hai
commesso un errore.

Una volta attivato il comando, la griglia di ritaglio apparirà sulla figura.
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Questa griglia mostra la parte della figura che sarà visualizzata, divisa in terzi come riferimento. Regola la
griglia cliccando e tenendo premuto su qualsiasi suo punto e poi trascinala nella posizione desiderata.

Quando la griglia ha assunto l'aspetto voluto, clicca su Applica per effettuare le modifiche. Se vuoi cancellare
le modifiche effettuate, clicca su Annulla.

CONSIGLIO: Fotografi professionisti di solito posizionano gli occhi e la bocca in un ritratto sulle "terze" linee.
Questo per bilanciare e rendere più piacevole la figura.

Puoi anche fissare il rapporto d'aspetto del ritaglio utilizzando la funzione Definizione Formato nel pannello di
controllo ritaglio. Per esempio potresti voler stampare un'immagine in 15x23 cm (questa è una misura
standard di stampa delle fotografie), e in questo modo lavorare in questo rapporto d'aspetto. Per fare ciò,
imposta i valori della Correzione Rapporto d'Aspetto cliccando sui riquadri Per: e Da: ed inserendo il valore di
rapporto che desideri. Una volta concluso, la griglia di ritaglio sarà fissata automaticamente su quel rapporto a
prescindere dalla posizione in cui la si muova.

3.5 Riconoscimenti Parti Terze

Portrait Professional utilizza un numero di librerie di terze parti, che sono elencate in questa sezione. Offriamo i
nostri ringraziamenti agli autori che ci hanno fornito queste preziose risorse.

dcraw

La lettura di immagini RAW è fornita da dcraw.

Copyright 1997-2012 by Dave Coffin, dcoffin a cybercom o net

http://www.cybercom.net/~dcoffin/dcraw/
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tifflib

La lettura e scrittura di immagini TIFF è fornita da libtiff.

Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its
documentation for any purpose is hereby granted without fee, provided that (i) the
above copyright notices and this permission notice appear in all copies of the
software and related documentation, and (ii) the names of Sam Leffler and Silicon
Graphics may not be used in any advertising or publicity relating to the software
without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.  

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY
OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE
USE OR PERFORMANCE OF THIS SOFTWARE.

jpeglib

La lettura e scrittura di immagini JPEG è fornita da jpegtiff.

This software is based in part on the work of the Independent JPEG Group.

This software is copyright (C) 1991-2011, Thomas G. Lane, Guido Vollbeding.

zlib

Il supporto per compressione Zlib è fornito da zlib.

(C) 1995-2012 Jean-loup Gailly and Mark Adler

Adobe DNG SDK

La lettura di DNG è fornita Adobe DNG SDK.

Lossless JPEG code adapted from:

Copyright (C) 1991, 1992, Thomas G. Lane.
Part of the Independent JPEG Group's software.

Copyright (c) 1993 Brian C. Smith, 
The Regents of the University of California
All rights reserved.

Copyright (c) 1994 Kongji Huang and Brian C. Smith. 
Cornell University
All rights reserved.

Permission to use, copy, modify, and distribute this software and its documentation
for any purpose, without fee, and without written agreement is hereby granted,
provided that the above copyright notice and the following two paragraphs appear in

http://www.libtiff.org/
http://www.ijg.org/
http://www.zlib.net/
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all copies of this software.

IN NO EVENT SHALL CORNELL UNIVERSITY BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE
AND ITS DOCUMENTATION, EVEN IF CORNELL UNIVERSITY HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE. 

CORNELL UNIVERSITY SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
THE SOFTWARE PROVIDED HEREUNDER IS ON AN "AS IS" BASIS, AND CORNELL UNIVERSITY HAS NO
OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICATIONS.

Copyright © 2006 Adobe Systems Incorporated. All rights reserved.

Adobe is a registered trademark or trademark of Adobe Systems Incorporated in the
United States and/or other countries. Windows is either a registered trademark or a
trademark of Microsoft Corporation in The United States and/or other countries. Mac is
a trademark of Apple Computer, Inc., registered in the United States and other
countries. All trademarks noted herein are the property of their respective owners.

Adobe XMP SDK

Adobe XMP SDK è utilizzato da Adobe DNG SDK

Copyright 2009 Adobe Systems Incorporated and others.  All rights reserved.  The
original version of this source code may be found at http://adobe.com.

lcms library

La gestione del profilo di colore ICC è fornita da lcms.

Little CMS

Copyright (c) 1998-2007 Marti Maria Saguer

Permission is hereby granted, free of charge, to any person obtaining a copy of this
software and associated documentation files (the "Software"), to deal in the Software
without restriction, including without limitation the rights to use, copy, modify,
merge, publish, distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies
or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

OpenCV

Localizzazione automatica delle parti del volto garantita dalla biblioteca Open CV

                          License Agreement

               For Open Source Computer Vision Library

http://adobe.com
http://www.littlecms.com/
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Copyright (C) 2000-2008, Intel Corporation, all rights reserved.

Copyright (C) 2008-2011, Willow Garage Inc., all rights reserved.

Third party copyrights are property of their respective owners.

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

  * Redistributions of source code must retain the above copyright notice, this list
of conditions and the following disclaimer.

  * Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

  * The name of the copyright holders may not be used to endorse or promote products
derived from this software without specific prior written permission.

This software is provided by the copyright holders and contributors "as is" and any
express or implied warranties, including, but not limited to, the implied warranties
of merchantability and fitness for a particular purpose are disclaimed. In no event
shall the Intel Corporation or contributors be liable for any direct, indirect,
incidental, special, exemplary, or consequential damages (including, but not limited
to, procurement of substitute goods or services; loss of use, data, or profits; or
business interruption) however caused and on any theory of liability, whether in
contract, strict liability, or tort (including negligence or otherwise) arising in any
way out of the use of this software, even if advised of the possibility of such
damage.

3.6 Tipologie di File Supportati

Portrait Professional è in grado di leggere e scrivere le seguenti tipologie di file:

Tipo Estensione Descrizione

JPEG .jpg; .jpeg Tipologia di file compresso che tende a perdere qualità.

TIFF .tif; .tiff Tipologia di file non compresso o che usa una compressione a perdita
minima.

Nota: I File TIFF contenenti immagini a 16 bit per campione di colore (48 bit
per pixel) sono supportati solo nell'Edizione Studio. 

PPX .ppx Tipo peculiare di file usato solo da Portrait Professional per registrare una
sessione.

Edizione Studio

Portrait Professional Studio supporta anche la lettura dei file RAW delle seguenti macchine fotografiche:

Casa Produttrice Tipo
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Adobe .dng

ARRI .ari

Canon .crw; .cr2

Epson .erf

Fuji .raf

Imacon .fff

Kodak .tif; .kdc; .dcr

Mamiya .mef; .mos

Minolta .mrw

Nikon .nef

Olympus .orf

Panasonic .raw; .rw2

Pentax .ptx; .pef

Phase One .tif; .iiq

Red .r3d

QuickTake .qtk

Sigma .x3f

Sony .arw; .srf; .sr2

 

3.7 Abbreviazioni Tastiera

Portrait Professional fornisce le seguenti abbreviazioni per tastiera nelle varie fasi del processo di
elaborazione dell'immagine:

Menu comandi

CTRL+O File > Apri

F4 Solo Edizione Studio 9
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File > Apri Gruppo

CTRL+S File > Salva

CTRL+W File > Chiudi

CTRL+E File > Migliora un altro viso in questa foto

CTRL+Z Edit > Annulla

CTRL+Y Edit > Ripristina

Schermata Iniziale

BARRA DI SPAZIO Attiva la finestra di dialogo Apri File per permetterti di selezionare il file da aprire.

Selezione Genere

f Imposta il viso come femminile, per poi passare alla fase di Posizionamento dei
Lineamenti.

m Imposta il viso come maschile, per poi passare alla fase di Posizionamento dei
Lineamenti.

Posizionamento Lineamenti

Non ci sono abbreviazioni per tastiera.

Regolazione Contorno

BARRA DI SPAZIO Passa al successivo lineamento da posizionare.  

Vai all'ultima fase della regolazione contorno.

Miglioramento Foto

+ Avvicina.

- Allontana.

INVIO
(se tenuto premuto)

Alterna l'immagine migliorata con quella originale.     
 

a Mostra/Nascondi Area Pelle

t Seleziona lo strumento Ritocco.

r Seleziona lo strumento Ripristino.

s Seleziona lo strumento Aumenta Area Pelle.



Riferimento 83

© 2013 Anthropics Technology Ltd.

d Seleziona lo strumento Riduci area Pelle.

h Seleziona lo strumento Aumenta Area Capelli.

j Seleziona lo strumento Riduci Area Capelli.

c Seleziona lo strumento Ritaglio.

[ Riduce il raggio del pennello (quando il pennello è stato selezionato).

] Aumenta il raggio del pennello (quando il pennello è stato selezionato).

0-9 Modifica l'opacità del pennello (quando il pennello è stato selezionato).

BARRA DI SPAZIO
(se tenuta premuta)

Passa momentaneamente allo strumento Scorrimento Manuale (quando un
pennello è selezionato).

SHIFT
(se tenuto premuto)

Passa temporaneamente al pennello opposto (quando un pennello è
selezionato).

ALT

(se tenuto premuto)    Blocca temporaneamente il radar (funziona solo quando è selezionato un Pennello di
Area). Utile per ritoccare piccoli dettagli come una ciocca di capelli.





Parte

IV
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4 Installation Guide

Una  volta  scaricato  Portrait  Professional,  il  programma  di  installazione  vi  guiderà  in  ogni
passo  del  processo.  Questa  sezione  vi  aiuterà  a  capire  le  diverse  fasi  del  processo  di
installazione.

Passo 1- avvio programma di installazione

Aprite  la  cartella  deve è stato salvato il  programma  e  cliccatelo  due  volte  per  aprire  il  file
DMG.
· Cliccate due volte sul file Portrait Professional.pkg per avviare l’installazione.  

Apertura del file DMG contenente il programma di installazione PKG 

Passo 2- Installazione Portrait Professional

Si apre la schermata di inizio del programma di installazione.  
· Cliccate Avanti per procedere all’installazione.  

Schermata di inizio del programma di installazione di Portrait Professional

Si apre la schermata principale di installazione da dove potrete selezionare la  cartella  nella
quale volete installare Portrait Professional
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Tipo di installazione- default

Selezionando cambia cartella di destinazione avrete accesso alla schermata di selezione
destinazione.  Qui  potete  selezionare  a  vostro  piacimento  la  cartella  dove  volete  installare
Portrait Professional.

· Dopo aver selezionato la cartella desiderata, cliccate Avanti per procedere alla prossima
schermata.  

Schermo destinazione schermo

Dopo  aver  selezionato  la  cartella  che  desiderate,  ritornerete  alla  schermata  principale
dell’installazione.

· Cliccando Installa il vostro Mac chiederà la password per avviare l’installazione. Immettete
la password per continuare l’installazione.
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Inserimento password per consentire l’installazione

Il  programma di  installazione completerà il  processo utilizzando le  impostazioni  che  avete
scelto.

Installazione...

Dopo  aver  installato  il  Portrait  Professional  sull’hard  disk,  apparirà  la  schermata  di  fine
installazione.

Installazione completata

Dopo aver installato con successo Portrait Professional, dovrete attivarlo prima di iniziare ad
utilizzarlo.
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Attivazione automatica

La prima volta che aprite Portrait Professional comparirà la schermata di attivazione. Vi verrà
richiesto di immettere il vostro codice di attivazione, che vi è stato mandato con l’e-mail per la
conferma dell’acquisto.

Schermo di attivazione automatica

Quando  attivate  Portrait  Professional  usando  il  metodo  di  attivazione  automatica  avete
bisogno  di  una  connessione  internet.  Se  volete  usare  l’attivazione  manuale,  fate
riferimento  alle  istruzioni  qui  di  seguito.  Quando  vi  trovate  alla  schermata  di  attivazione
automatica,  inserite  il  codice di  attivazione che vi  e’  stato  mandato nell’e-mail  di  conferma
dell’acquisto e cliccate Attivare.
 

Una volta che il vostro codice e’ stato verificato, Portrait Professional  potrà  essere aperto  e
sarà pronto per l’uso.
  

Se volete attivare la licenza di Portrait Professional su un computer senza la connessione
internet, fate riferimento alla Guida del Manuale di Attivazione .

Solo per l’Edizione Studio

Se volete usare Portrait  Professional  come plug-in  per  altre  applicazioni  come Photoshop,
dovrete installare il plug-in.
Il processo verrà spiegato più dettagliatamente nella Guida di Installazione del Plug-in.

4.1 Attivazione Manuale

Attivazione Manuale

L’attivazione manuale e’ usata quando non e’ attiva una connessione ad internet. Se si era
connessi durante il processo di attivazione, si raccomanda di usare l’Attivazione Automatica.

89

9

92
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Le istruzioni per l’uso dell’Attivazione Automatica possono essere trovate nella Guida
d’Installazione . 

Schermo Per l’Attivazione Manuale

Se non riesci ad attivare il Portrait Professional con l’Attivazione Automatica, clicca sul
pulsante Attivazione Manuale per iniziare il processo manualmente. Inizia inserendo il codice
fornito dal sistema attraverso una mail ,composto da 24 numeri , nello schermo di attivazione
manuale, che è unico per il tuo computer. 

In un computer con una connessione internet ,visitate http://www.portraitprofessional.com/
activate e entrate il numero di attivazione provvedueto nell’email di acquisto e dal manuale di
attivazione.

Attivazione Manuale della Pagina Web

Immetti il numero di Attivazione nel sito & clicca sul pulsante Ottenere Chiave. Ti verrà
fornito un link dal quale scaricare la chiave.

86
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Installation Guide 91

© 2013 Anthropics Technology Ltd.

· Clicca Scaricare la Chiave e salva il file su una chiavetta USB in modo da poterla
trasferita nel computer pur non disponendo si una connessione Internet. Nomina il file
Ppchiave.txt

Scaricare la Chiave

Inserisci la chiavetta USB con il file PPchiave.txt nel computer in cui hai installato il Portrait
Professional. Apri Portrait Professional e torna nuovamente alla schermata di Attivazione
Manuale. Adesso hai la possibilità di scegliere tra due modi di attivazione di Portrait
Professional. Il modo più semplice è quello di cliccare sul pulsante di Scaricare la Chiave
dal File e selezionate il file PPchiave dalla penna USB come mostrato sotto. Dopo aver
selezionato il file PPchiave, Portrait Professional dovrebbe essere istallato correttamente.

Scaricare la Chiave dal File

In alternativa, puoi selezionare Copia la Chiave dalla Clipboard per attivare manualmente
Portrait Professional. In questo caso, devi aprire il file text cliccando due volte il file
Ppchiave.txt. PremereCMD+A per evidenziare il testo nel file chiave. Quindi premere CMD+C per

copiare il testo negli appunti. Torna sullo schermo dell’Attivazione Manuale e cliccate Copiate la
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chiave dalla Clipboard. 

Licenza Attivata

4.2 Guida per l’Installazione de Plug-in

Solamente per l’Edizione Studio

Istallazione del Plug-in del Portrait Professional

Con l’edizione Studio & Studio 64 di Portrait Professional, hai la possibilità di usare Portrait
Professional come plug-in  per Photoshop o altri programmi compatibili.

Durante  l’installazione,  il  programma  individuerà  automaticamente  ogni  applicazione
compatibile.

Dopo  aver  selezionato  la  destinazione  dell’installazione,  il  programma  di  installazione
eseguirà una scansione per trovare i software compatibili con il plug-in.

Installazione del Plug-in di Photohop

9

22
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Installazione del Plug-in di Aperture

Una  volta  confermata  con  quale  applicazione  vorrete  usare  il  plug-in,  procedete  con
l’installazione e verranno installati sia Portrait Professional che il plug-in selezionato.

(nota:  Il  plug-in  può  essere  installato  da  Portrait  Professional  in  ogni  momento  cliccando
Portrait Professional> Preferenze> Plug-in> Avvia Installazone Plug-in)

Installa il Plug-in dalle Preferenze di Portrait Professional
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Installare nuovamente il plug-in

Se non hai installato il plug-in contemporaneamente al Portrait Professional, puoi sempre
farlo successivamente.

Basta andate nella sezione Impostazioni plug-in , e iniziare l’installazione.

Problemi nell’uso del Software

Se il plug-in di Portrait Professional non appare in Photoshop (o in un’altra applicazione
compatibile), potrebbe non essere stato installato correttamente. Un motivo potrebbe essere
che è stato installato nella cartella sbagliata.

Per risolvere il problema, bisogna selezionare la cartella giusta per installare il plug-in. Di
solito si trova in "/Applications/<NOME-APPLICAZIONE>/Plug-Ins" per esempio, "/Application/

Adobe Photoshop CS5/Plug-ins/".  Quando hai trovato la giusta cartella, installa il plug-in dalla
finestra delle Impostazioni Plug-in e seleziona l’opzione “Installazione Manuale”

65

65
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